NOTICE

The information in this document is subject to change without notice and should not be construed as a commitment by Waters Corporation. Waters Corporation assumes no responsibility for any errors that may appear in this document. This document is believed to be complete and accurate at the time of publication. In no event shall Waters Corporation be liable for incidental or consequential damages in connection with, or arising from, the use of this document.

© 2002 WATERS CORPORATION. PRINTED IN THE UNITED STATES OF AMERICA. ALL RIGHTS RESERVED. THIS DOCUMENT OR PARTS THEREOF MAY NOT BE REPRODUCED IN ANY FORM WITHOUT THE WRITTEN PERMISSION OF THE PUBLISHER.

Millennium and Waters are registered trademarks, and Empower, LAC/E, and SAT/IN are trademarks of Waters Corporation.

Microsoft, MS, Windows, and Windows NT are registered trademarks of Microsoft Corporation.

Oracle, SQL*Net, and SQL*Plus are registered trademarks, and Oracle8, Oracle8i, and Oracle9i are trademarks of Oracle Corporation.

Pentium and Pentium II are registered trademarks of Intel Corporation.

TCP/IP is a trademark of FTP Software, Inc.

All other trademarks or registered trademarks are the sole property of their respective owners.
2.4 Changing the Oracle User Accounts Passwords .......... 31
2.5 Changing the Empower System User Account Password .... 32
2.6 Logging Out of the Operating System.......................... 33

Chapter 3
Managing the Server ................................................................. 34
3.1 Starting the Server............................................................... 34
3.2 Starting Up and Shutting Down the Empower Database ..... 35
  3.2.1 Starting Up the Empower Database ......................... 35
  3.2.2 Shutting Down the Empower Database .................... 36
3.3 Shutting Down the Empower System............................... 36
  3.3.1 Shutting Down the Server........................................ 36
  3.3.2 Shutting Down the Clients and Chromatographic Systems ........................................ 37
3.4 Managing Operating System and Oracle User Accounts and Passwords........................................ 37
3.5 Archiving Alert Logs............................................................ 38
3.6 Organizing Server Storage .................................................... 38
  3.6.1 Server Hard Drive Organization............................... 38
  3.6.2 Database File Organization ..................................... 39
3.7 Managing the Server Disk Space ........................................ 41
  3.7.1 Checking Free Disk Space .................................... 41
  3.7.2 Increasing Free Disk Space...................................... 42
  3.7.3 Defragmenting the Hard Disk ................................. 43
  3.7.4 Defragmenting the Database................................. 43
3.8 Backing Up and Restoring Server Disk Images ............... 48
3.9 Backing Up the Empower Database ............................. 50
3.9.1 Performing a Hot Backup to Drive ................................................ 54
3.9.2 Performing a Hot Backup to Tape ................................................ 55
3.9.3 Performing a Cold Backup to Drive ............................................. 55
3.9.4 Performing a Cold Backup to Tape ............................................. 55

3.10 Restoring the Empower Database ................................................. 56
3.10.1 Backup Set Structures .......................................................... 57
3.10.2 Recovering from an Empower Database Drive Failure .............. 61
3.10.3 Recovering from an Empower Raw Data Drive Failure ............. 63
3.10.4 Recovering from an Empower Program Files Disk Failure ......... 65
3.10.5 Recovering from a Database and Raw Data Drive Failure ......... 66
3.10.6 Unusual Recovery Conditions .............................................. 66

3.11 Configuring a Listener Service .................................................. 67

Chapter 4
Managing the Clients ........................................................................... 72

4.1 Adding a Client Workstation ......................................................... 73
  4.1.1 Before You Begin ............................................................... 73
  4.1.2 Installing the Empower Client Software .................................. 73

4.2 Configuring a Database Service Name ......................................... 75
  4.2.1 Defining the List of Database Aliases ...................................... 79

4.3 Registering Acquisition Server Printers ...................................... 80

4.4 Deleting a Client Workstation or LAC/E³² Acquisition Server ................. 81
4.5 Starting and Logging In to Empower Software ......................... 82
4.6 Logging Out of Empower Software ...................................... 83
4.7 Managing User Types .......................................................... 83
  4.7.1 Creating User Types .................................................. 83
  4.7.2 Modifying or Viewing User Types ................................ 84
  4.7.3 Deleting User Types .............................................. 84
4.8 Managing User Accounts .................................................... 85
  4.8.1 Creating User Accounts ............................................. 85
  4.8.2 Modifying or Viewing User Accounts ............................ 86
  4.8.3 Deleting User Accounts ............................................. 87
4.9 Managing User Groups ........................................................ 88
  4.9.1 Creating User Groups ................................................ 88
  4.9.2 Modifying or Viewing User Groups ............................... 88
  4.9.3 Deleting User Groups ............................................. 89
4.10 Managing Raw Data Files .................................................. 89
4.11 Copying User Preferences .................................................. 91
4.12 Managing Database Properties .......................................... 92
  4.12.1 Changing the Empower Database Password ................. 93
  4.12.2 Managing the Tablespaces ...................................... 93
4.13 Backing Up and Restoring Projects .................................... 95
  4.13.1 Configuring the Backup Utility (Optional) .................... 95
  4.13.2 Backing Up Empower Projects ................................. 96
  4.13.3 Restoring Empower Projects .................................... 98
4.14 Using System Monitor ....................................................... 102
Chapter 5
Managing the LAC/E$^{32}$ Acquisition Server ........................................ 103

5.1 Setting Up a LAC/E$^{32}$ Acquisition Server .................................... 103
  5.1.1 Setting Up the Remote Administration Computer...................... 103
  5.1.2 Setting Up the LAC/E$^{32}$ Acquisition Server ...................... 104

5.2 Starting, Stopping and Rebooting the LAC/E$^{32}$ Acquisition
  Server .................................................................................. 105
  5.2.1 Starting the LAC/E$^{32}$ Acquisition Server ......................... 105
  5.2.2 Shutting Down the LAC/E$^{32}$ Acquisition Server ............... 105
  5.2.3 Remotely Rebooting the LAC/E$^{32}$ Acquisition
       Server ........................................................................... 105

5.3 Deleting a LAC/E$^{32}$ Acquisition Server .................................. 106

5.4 Buffering and Recovering Data .................................................. 106

Chapter 6
Troubleshooting ............................................................................. 108

6.1 Isolating Problems ................................................................. 108
  6.1.1 Recommendations ......................................................... 109
  6.1.2 Recording Problems ....................................................... 110

6.2 Reporting Problems ................................................................ 110

6.3 Software Problems .................................................................. 111

6.4 Hardware Problems .............................................................. 114

6.5 Troubleshooting Procedures ................................................... 117
  6.5.1 Evaluating Windows XP or Windows 2000 Error
       Messages ........................................................................... 117
  6.5.2 Evaluating Empower Error Messages ............................... 117
  6.5.3 Evaluating Oracle Error Messages ................................. 117
<table>
<thead>
<tr>
<th>Appendix A</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Forms</td>
<td>.....................................................................................</td>
<td>118</td>
</tr>
<tr>
<td>Appendix B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Glossary</td>
<td>.....................................................................................</td>
<td>125</td>
</tr>
<tr>
<td>Index</td>
<td>.....................................................................................</td>
<td>130</td>
</tr>
</tbody>
</table>

Table of Contents
# List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>Example of Empower Enterprise and Workgroup System Architecture</td>
<td>20</td>
</tr>
<tr>
<td>2-1</td>
<td>Windows Security Dialog Box</td>
<td>30</td>
</tr>
<tr>
<td>2-2</td>
<td>Change Password Dialog Box</td>
<td>30</td>
</tr>
<tr>
<td>3-1</td>
<td>System (C:) Properties Dialog Box with General Tab Selected</td>
<td>42</td>
</tr>
<tr>
<td>3-2</td>
<td>Windows 2000 Media Pool Names</td>
<td>54</td>
</tr>
<tr>
<td>3-3</td>
<td>Hot Drive Backup Set Structure</td>
<td>58</td>
</tr>
<tr>
<td>3-4</td>
<td>Hot Tape Backup Set Structure</td>
<td>59</td>
</tr>
<tr>
<td>3-5</td>
<td>Cold Drive Backup Set Structure</td>
<td>60</td>
</tr>
<tr>
<td>3-6</td>
<td>Cold Tape Backup Set Structure, Windows 2000</td>
<td>61</td>
</tr>
<tr>
<td>3-7</td>
<td>Oracle Net Configuration Assistant: Welcome Page</td>
<td>68</td>
</tr>
<tr>
<td>3-8</td>
<td>Listener Configuration, Listener Name Page</td>
<td>69</td>
</tr>
<tr>
<td>3-9</td>
<td>Listener Configuration, TCP/IP Protocol Page</td>
<td>70</td>
</tr>
<tr>
<td>3-10</td>
<td>Listener Configuration, Select Listener Page</td>
<td>71</td>
</tr>
<tr>
<td>4-1</td>
<td>Empower Program Folder</td>
<td>74</td>
</tr>
<tr>
<td>4-2</td>
<td>Oracle Net Configuration Assistant: Welcome Page</td>
<td>75</td>
</tr>
<tr>
<td>4-3</td>
<td>Net Service Name Configuration, Database Version Page</td>
<td>76</td>
</tr>
<tr>
<td>4-4</td>
<td>Net Service Name Configuration, Service Name Page</td>
<td>77</td>
</tr>
<tr>
<td>4-5</td>
<td>Net Service Name Configuration, TCP/IP Protocol Page</td>
<td>78</td>
</tr>
<tr>
<td>4-6</td>
<td>Sample WatNames.ora File</td>
<td>79</td>
</tr>
<tr>
<td>4-7</td>
<td>Register Acquisition Server Printers Dialog Box</td>
<td>81</td>
</tr>
<tr>
<td>4-8</td>
<td>Empower Login Dialog Box</td>
<td>82</td>
</tr>
<tr>
<td>4-9</td>
<td>Manage Raw Data Files Dialog Box</td>
<td>90</td>
</tr>
<tr>
<td>4-10</td>
<td>Copy Preferences Dialog Box</td>
<td>92</td>
</tr>
<tr>
<td>4-11</td>
<td>Database Properties Dialog Box</td>
<td>94</td>
</tr>
<tr>
<td>4-12</td>
<td>Backup Options Dialog Box</td>
<td>95</td>
</tr>
<tr>
<td>Figure</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>4-13</td>
<td>Backup Project Wizard - Comment Entry Page</td>
<td>96</td>
</tr>
<tr>
<td>4-14</td>
<td>Backup Project Wizard - Select Destination Page</td>
<td>97</td>
</tr>
<tr>
<td>4-15</td>
<td>Backup Project Wizard - Start Page</td>
<td>98</td>
</tr>
<tr>
<td>4-16</td>
<td>Restore Project(s) Wizard - Start Software Page</td>
<td>99</td>
</tr>
<tr>
<td>4-17</td>
<td>Restore Project Wizard - Quota Entry Page</td>
<td>100</td>
</tr>
<tr>
<td>6-1</td>
<td>Isolating System Problems</td>
<td>109</td>
</tr>
</tbody>
</table>
List of Tables

1-1 Hardware ................................................................. 23
1-2 Software ............................................................... 23
1-3 Server Tasks ............................................................. 24
1-4 Client Tasks ............................................................. 25

3-1 Typical Server Disk Configuration ................................. 39
3-2 Empower Default File Organization .............................. 40
3-3 Tape Rotation Schedule ............................................. 49
3-4 Database Backup Scripts ........................................... 51

4-1 Origin of Full Audit Trail Settings ............................... 101

6-1 Troubleshooting Software Problems ............................ 111
6-2 Troubleshooting the LAC/E³² Acquisition Server ............ 114
6-3 Troubleshooting the Printer ....................................... 115
The Empower Software System Administrator’s Guide provides the information you need to perform administrative tasks for the Empower™ Enterprise client/server and Workgroup configurations. It includes procedures for performing administrative tasks for server, client, and acquisition server computers in these configurations.

This guide is for experienced system administrators. While the system administrator’s expertise can be in chemistry and/or chromatography with an understanding of chromatography principles and basic Empower software, the administrator should also have a good understanding of computer concepts and hardware, and a working knowledge of networks in general. In addition, the administrator should be experienced with the following:

- Real-time data acquisition systems
- Intel® Pentium® servers
- Windows® 2000 or Windows XP
- Networking
- TCP/IP
- Oracle® software

Note: Hardware installation and configuration tasks are typically handled by an IT representative using appropriate product documentation. As with network installation and configuration, general hardware installation and configuration tasks are beyond the scope of this document but are critical to the successful operation of the Empower System. Please consult your hardware documentation for assistance in configuring computer hardware.

Organization

This guide contains the following:

Chapter 1 describes the Empower Enterprise client/server system and Workgroup configuration.

Chapter 2 describes procedures for accessing the server.

Chapter 3 describes procedures for managing the server.

Chapter 4 describes how to manage the Empower clients. It includes procedures such as logging in to and out of Empower, managing user accounts and user groups, backing up and restoring projects, and adding and deleting client workstations.
Chapter 5 describes how to manage the Empower LAC/E™32 Acquisition Servers. It includes procedures such as setting up and configuring the servers, and starting up and shutting down the servers.

Chapter 6 provides troubleshooting information.

Appendix A contains sample log forms for recording important system information.

Appendix B defines commonly used Empower terms.

Related Documentation

**Waters Licenses, Warranties, and Support:** Provides software license and warranty information, describes training and extended support, and tells how Waters handles shipments, damages, claims, and returns.

**Online Documentation**

**Empower Help:** Describes all Empower windows, menus, menu selections, and dialog boxes for the base software and software options. Also includes reference information and procedures for performing all tasks required to use Empower software. Included as part of the Empower software.

**Empower Read Me File:** Describes product features and enhancements, helpful tips, installation and/or configuration considerations, and changes since the previous version.

**Empower LIMS Help:** Describes how to use the Empower LIMS Interface to export results and import worklists.

**Empower Toolkit Professional Help:** Describes how to use the common-object-model, message-based protocol to communicate with the Empower software from a third-party application.

**Printed Documentation for Base Product**

**Empower Software Getting Started Guide:** Provides an introduction to the Empower software. Describes the basics of how to use Empower software to acquire data, develop a processing method, review results, and print a report. Also covers basic information for managing projects and configuring systems.

**Empower Software Data Acquisition and Processing Theory Guide:** Provides theories pertaining to data acquisition, peak detection and integration, and quantitation of sample components.

**Empower System Installation and Configuration Guide:** Describes Empower software installation, including the stand-alone Personal workstation, Workgroup
configuration, and the Enterprise client/server system. Discusses how to configure the computer and chromatographic instruments as part of the Empower System. Also covers the installation, configuration, and use of acquisition servers such as the LAC/E module, the busLAC/E™ card, and interface cards used to communicate with serial instruments.

**Empower System Upgrade and Configuration Guide:** Describes how to add hardware and upgrade the Empower software using an import-and-export upgrade method.

**Empower Software System Administrator’s Guide:** Describes how to administer the Empower Enterprise client/server system and Workgroup configuration.

**Empower Software Release Notes:** Contains last-minute information about the product. Also provides supplementary information about specific Empower software releases.

### Printed Documentation for Software Options

**Empower System Suitability Quick Reference Guide:** Describes the basics of the Empower System Suitability option and describes the equations used by the System Suitability software.

**Empower PDA Software Getting Started Guide:** Describes the basics of how to use the Empower PDA option to develop a PDA processing method and to review PDA results.

**Empower GC Software Getting Started Guide:** Describes how to use the Empower GC option to develop a GC processing method and to review GC results.

**Empower GPC Software Getting Started Guide:** Describes how to use the Empower GPC option to develop a GPC processing method and to review GPC results.

**Empower GPCV Software Getting Started Guide:** Describes how to use the Empower GPCV option to develop a GPCV processing method and to review GPCV results.

**Empower Light Scattering Software Getting Started Guide:** Describes how to use the Empower Light Scattering option to develop a light scattering processing method and to review light scattering results.

**Empower ZQ Mass Detector Software Getting Started Guide:** Describes installation, configuration, calibration, and tuning methods, as well as how to operate the ZQ Mass Detector with Empower software.
Empower Chromatographic Pattern Matching Software Getting Started Guide: Describes how to use the Chromatographic Pattern Matching option to develop a pattern matching processing method and to review pattern matching results.

Empower Dissolution System Software Quick Start Guide: Describes how to operate the Alliance® Dissolution System using Empower software.

Empower Toolkit Programmer’s Reference Guide: Describes how to use the common-object-model, message-based protocol to communicate with Empower software from a third-party application.

Waters Integrity System Getting Started Guide: Describes features of the Waters Integrity® System and provides step-by-step tutorials that guide a user through the use of the Empower Mass Spectrometry (MS) option.

Empower AutoArchive Software Installation and Configuration Guide: Describes how to install and configure the Empower AutoArchive option.

Documentation on the Web


Related Adobe Acrobat Reader Documentation

For detailed information about using Adobe® Acrobat® Reader, see the Adobe Acrobat Reader Online Guide. This guide covers procedures such as viewing, navigating, and printing electronic documentation from Adobe Acrobat Reader.

Printing This Electronic Document

Adobe Acrobat Reader lets you easily print pages, page ranges, or the entire document by selecting File > Print. For optimum print quantity, Waters recommends that you specify a PostScript® printer driver for your printer. Ideally, use a printer that supports 600 dpi print resolution.
Documentation Conventions

The following conventions can be used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purple</strong></td>
<td>Purple text indicates user action such as keys to press, menu selections, and commands. For example, “Click <strong>Next</strong> to go to the next page.”</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Italic indicates information that you supply such as variables. It also indicates emphasis and document titles. For example, “Replace <strong>file_name</strong> with the actual name of your file.”</td>
</tr>
<tr>
<td><strong>Courier</strong></td>
<td>Courier indicates examples of source code and system output. For example, “The <strong>SVRMGR&gt;</strong> prompt appears.”</td>
</tr>
<tr>
<td><strong>Courier Bold</strong></td>
<td>Courier bold indicates characters that you type or keys you press in examples of source code. For example, “At the <strong>LSNRCTL&gt;</strong> prompt, enter <strong>set password oracle</strong> to access Oracle.”</td>
</tr>
<tr>
<td><strong>Underlined Blue</strong></td>
<td>Indicates hypertext cross-references to a specific chapter, section, subsection, or sidehead. Clicking this topic using the hand symbol brings you to this topic within the document. Right-clicking and selecting <strong>Go Back</strong> from the shortcut menu returns you to the originating topic. For example, “You control and maintain the Empower system by performing system administration tasks as indicated in <strong>Section 1.4.2, System Administration Tasks</strong>”</td>
</tr>
<tr>
<td><strong>Keys</strong></td>
<td>The word <strong>key</strong> refers to a computer key on the keypad or keyboard. <strong>Screen keys</strong> refer to the keys on the instrument located immediately below the screen. For example, “The A/B screen key on the 2414 Detector displays the selected channel.”</td>
</tr>
<tr>
<td>...</td>
<td>Three periods indicate that more of the same type of item can optionally follow. For example, “You can store <strong>filename1</strong>, <strong>filename2</strong>, ... in each folder.”</td>
</tr>
<tr>
<td><strong>&gt;</strong></td>
<td>A right arrow between menu options indicates you should choose each option in sequence. For example, “Select <strong>File &gt; Exit</strong>” means you should select <strong>File</strong> from the menu bar, then select <strong>Exit</strong> from the <strong>File</strong> menu.”</td>
</tr>
</tbody>
</table>

**Notes**

Notes call out information that is helpful to the operator. For example:

*Note:* Record your result before you proceed to the next step.
Attentions

Attentions provide information about preventing damage to the system or equipment. For example:

**Attention:** To avoid damaging the detector flow cell, do not touch the flow cell window.

Cautions

Cautions provide information essential to the safety of the operator. For example:

**Caution:** To avoid burns, turn off the lamp at least 30 minutes before removing it for replacement or adjustment.

**Caution:** To avoid electrical shock and injury, turn off the detector and unplug the power cord before performing maintenance procedures.

**Caution:** To avoid chemical or electrical hazards, observe safe laboratory practices when operating the system.
Chapter 1
Introduction

This chapter introduces you to the Waters® Empower™ Enterprise client/server system and the Empower Workgroup configuration. It describes the Empower system, hardware and software requirements, system administrative tasks, and security. Terms that appear in this guide are defined in Appendix B, Glossary, which you can review before using the Empower system.

**Note:** This guide is for administrators of both the Empower Enterprise client/server system and the Empower Workgroup configuration. Throughout this guide, references to an Enterprise server also pertain to a Workgroup primary PC. References to an Enterprise client also pertain to a Workgroup secondary PC and a Workgroup primary PC.

1.1 System Overview

The Empower Enterprise client/server system and Workgroup configuration are networked versions of the Empower Personal standalone workstation. The architecture of these systems provide:

- A central database on the server
- Distributed acquisition
- Distributed processing
- Security

**Features**

The Empower Enterprise client/server system and Empower Workgroup configuration:

- Provide a central password-protected database located on a server running Windows® 2000 Professional
- Support multiple client computers running the Empower software application under Windows 2000 Professional or Windows XP Professional
- Allow client computers to access and use data, methods, and results on the Empower server
• Permit client computers to control and acquire data from chromatography systems:
  – Locally and remotely through a Waters Bus Laboratory Acquisition and Control/Environment (busLAC/E™) card installed in the client computer
  – Over the network through a Waters LAC/E™32 Acquisition Server
• Allow users to lock methods to prevent modification by other users
• Protect raw data methods and processed results using a sophisticated security grid
• Use standard network connections
• Support multiple network printers
• Locate any result quickly and easily using sample identifiers (not just the sample name) suited to your needs
• Locate results using any parameter (or set of parameters) to visualize tracking and trending of results
• Plot trend, control, and run charts (using the Empower System Suitability option)
• Calculate means, standard deviation, and relative standard deviation (RSD) for replicates
• Share chromatographic data among users and projects in a client/server configuration
• Import raw data files into, and exports raw data or results from, the Empower database
• Maintains an audit trail of system-wide activities such as changes to projects, systems, users, default strings, libraries, and so on
• Maintain an audit trail of project-specific activities such as changes to methods, results, and samples for a project (using the Full Audit Trail Support feature)
• Provide full database and raw data backup and restore functions from the server using Oracle® Standard Edition software
• Allows the restoration of projects from previous versions of Millennium™32 software

1.2 Hardware Configuration Example

Figure 1-1 illustrates the concept of the Empower Enterprise and Workgroup architecture where different components reside on different computers.
Figure 1-1  Example of Empower Enterprise and Workgroup System Architecture
1.3 Software Description

This section describes the software components required to implement the Empower Enterprise or Workgroup systems.

1.3.1 Server Software

The server software consists of:

- Windows 2000 Server operating system, Service Pack 2
- Oracle Standard Edition version 9.0.1
- Internet Explorer version 6.0, Internet Explorer version 5.5, Service Pack 1, or Internet Explorer version 5.5, Service Pack 2

**Windows 2000 Server Operating System**

The Windows 2000 operating system provides built-in networking utilities, protocol handlers, and services, including basic file and print services, and client/server application functionality.

**Oracle Standard Edition 9i Server**

The Empower relational database resides on the server in an Empower Enterprise client/server system or an Empower Workgroup configuration. Information from projects, such as processed results, sample identifiers, and methods is stored in the Empower database. The chromatographic raw data is not stored in the database. The raw data files are stored on the same or a different server disk.

Oracle client software provides the Empower application running on the client computer with access to the Empower database.

1.3.2 Client Software

The client software runs on the PC and communicates with the corresponding software components on the server, as applicable. The client software includes the following:

- Windows 2000 Professional, Service Pack 2 or Windows XP Professional operating system
- Empower Enterprise or Empower Workgroup software
- Oracle Standard Edition version 9.0.1
- Internet Explorer version 6.0, Internet Explorer version 5.5, Service Pack 1, or Internet Explorer version 5.5, Service Pack 2
Windows 2000 or Windows XP Operating System

Windows 2000 or Windows XP on the client provides the connectivity software that communicates with the server through TCP/IP. Windows 2000 or Windows XP combined with TCP/IP services for the operating system provide the Empower application with:

- Access to the Empower client and LAC/E³² setup application on the server
- Access to the Empower database information on the server
- Access to raw data files on the server or other computer on the network
- Access to network printers

Empower Software

Empower Software is a 32-bit data acquisition and management application with advanced integrated database architecture. It acquires, processes, reports, and manages chromatographic information. Empower Software offers easy-to-use technology and converts high-quality, accurate results into usable information while meeting security and regulatory compliance requirements. It is a complete chromatography and results management system that links raw data to the acquisition, processing, and reporting methods, as well as processing results. You can adapt it to your individual chromatography requirements by using as many or as few Empower Software capabilities as you require.

Empower Software allows you to:

- Acquire data and control chromatographic instrumentation
- Process data interactively or in the background
- Customize management of project information
- Customize report design and generation

Using Empower Software, you can start out with simple acquisition and processing requirements, such as:

- Making a single injection
- Processing data
- Printing a report

You can then progress to more advanced tasks, such as:

- Interactively creating and acquiring sample sets
- Defining custom reports
- Creating and adding custom fields, and calculating custom database results
- Performing tracking and trending of results using the Empower database
Oracle Client Software Using TCP/IP

Oracle client software provides the Empower application with access to the Empower database through TCP/IP.

1.4 System Administration

Managing the Empower Enterprise or Workgroup system involves maintaining all the hardware components, operating system software, networking software, and application programs that make up the Empower software. This includes becoming familiar with the system workload to anticipate changes, problems, and growth.

1.4.1 System Administrator Qualifications

The system administrator is responsible for the smooth and efficient daily operation of the Empower system. You control and maintain the Empower system by performing system administration tasks as indicated in Section 1.4.2, System Administration Tasks.

To effectively administer the Empower system, you must be familiar with the operation of the hardware and software listed in Table 1-1 and Table 1-2.

Table 1-1 Hardware

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server computer and peripherals</td>
<td>Server documentation</td>
</tr>
<tr>
<td>Waters LAC/E³² Acquisition Server</td>
<td>Empower System Installation and Configuration Guide</td>
</tr>
<tr>
<td>Empower Software</td>
<td>Empower System Installation and Configuration Guide and the Empower Help</td>
</tr>
<tr>
<td>PCs and printers</td>
<td>PC and printer manufacturer’s documentation</td>
</tr>
</tbody>
</table>

Table 1-2 Software

<table>
<thead>
<tr>
<th>Software</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empower Software</td>
<td>Empower System Installation and Configuration Guide and the Empower Help</td>
</tr>
<tr>
<td>Windows 2000 or Windows XP operating system</td>
<td>Microsoft Windows 2000 or Windows XP Getting Started Guide and the Windows 2000 or Windows XP Help</td>
</tr>
<tr>
<td>Oracle9™</td>
<td>Oracle9i Server online documentation</td>
</tr>
<tr>
<td>Microsoft TCP/IP</td>
<td>Microsoft Windows Help</td>
</tr>
</tbody>
</table>
1.4.2 System Administration Tasks

This section describes the routine and periodic system administration tasks you need to perform to keep the Empower system running efficiently. You use a variety of tools to help you perform system administration tasks, including:

- Empower Help
- Empower Configuration Manager
- Windows 2000 and Windows XP Operating System Help Systems and Utilities
- Oracle9i Help System and Utilities

**Routine Tasks**

Routine system administration tasks are those that you should perform regularly, for example, once daily, once each shift (every 8 hours), or once a week. Routine system administration tasks apply to both the server and the client.

**Periodic Tasks**

Periodic system administration tasks are those that you perform occasionally or as the need arises. As the system administrator, you must determine when to perform periodic system administration tasks based on your Empower system use and requirements.

Periodic system administration tasks apply to both the server and the client.

**Server Tasks**

Typical server tasks and chapter references are in Table 1-3.

Table 1-3 Server Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
<th>Recommended Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checking disk space and status</td>
<td>Section 3.7, Managing the Server Disk Space</td>
<td>Daily</td>
</tr>
<tr>
<td>Checking project tablespace</td>
<td>Section 4.12, Managing Database Properties</td>
<td>Daily</td>
</tr>
<tr>
<td>Backing up the Empower database</td>
<td>Section 3.9, Backing Up the Empower Database</td>
<td>Weekly cold backups with daily hot backups</td>
</tr>
<tr>
<td>Backing up the server</td>
<td>Section 3.8, Backing Up and Restoring Server Disk Images</td>
<td>Weekly or as needed</td>
</tr>
</tbody>
</table>
Client T asks
You initiate periodic and routine client tasks from the Empower Configuration Manager on the client PC. Typical client routine tasks and chapter references are in Table 1-4.

<table>
<thead>
<tr>
<th>Table 1-4  Client Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
</tr>
<tr>
<td>Checking tablespace size and status</td>
</tr>
<tr>
<td>Backing up, restoring, and deleting projects</td>
</tr>
<tr>
<td>Installing new clients</td>
</tr>
<tr>
<td>Configuring the LAC/E32 Acquisition Server</td>
</tr>
<tr>
<td>Managing user types</td>
</tr>
<tr>
<td>Managing users</td>
</tr>
</tbody>
</table>
System Administrator’s Log

Set up and maintain a system administrator’s log to record all system administration tasks. Keep the log next to the system to record system administration information, such as free disk space or the date of the last backup. Also, keep a record of any problems you have with the system, as well as the resolution of the problems.

See Appendix A, Log Forms, for various types of sample log forms.

1.4.3 User Accounts

User accounts allow access to various system functions. Different types of user accounts are used with the operating system (Windows 2000 or Windows XP), Oracle, and the Empower software.

Operating System Accounts

The operating system accounts include (Windows 2000 or Windows XP accounts):

- Administrator
- Typical user accounts (created in the network domain)

Oracle Accounts

The Oracle accounts include:

- Sys
- System

Empower Accounts

The Empower accounts include:

- Empower system administrator accounts
- Typical user accounts
Changing Account Passwords

To maintain security, change the passwords for the Windows 2000 Administrator, Oracle accounts, and Empower System accounts immediately after installing your Empower System and, subsequently, as required by your company policy.

Note: Waters recommends that you do not change the internal password that the Empower software uses to log in to the Oracle database. If your company policy requires you to change this password, be certain to change it properly from the Configuration Manager window. Do not change this password directly in Oracle. Follow the procedure exactly as outlined in Section 4.12.1, Changing the Empower Database Password.

Windows 2000 Administrator Account Privileges

The Windows 2000 Administrator account includes all privileges on the server. With Administrator account privileges, you have full access to:

- All public, personal, and system files and directories
- Empower database files
- Empower raw data files
- All Windows 2000 user accounts and account information

For more information on Windows 2000 privileges, see the Windows 2000 Help and user documentation.

Empower System Account Privileges

The Empower System account includes all Empower privileges on the client. With the Empower System account privileges, you have full access to:

- All user account information
- All group account information
- All project information

1.5 Empower Security Features

The Empower Enterprise and Workgroup systems provide the server and the client with several levels of security that safeguard methods, projects, and raw data in the Empower system.

1.5.1 Server Security

The server provides security through the operating system, and Oracle and Empower software user accounts.
Windows 2000 Operating System

The Administrator account and the operating system provide security for all files on the server. An Administrator account allows unlimited access to the Empower database files and all Windows 2000 server files.

Other operating system user accounts are created in the network domain and should be supplied with appropriate privileges and user rights.

Oracle Database Users

The Oracle database users protect the Empower database from unauthorized:

- Use
- Modification
- Startup
- Shut down

Only the Oracle database users can provide access to database functions. See the Windows Help and Oracle Help for information on managing accounts and passwords.

1.5.2 Client Security

The Empower client provides security through the:

- Windows 2000 or Windows XP login
- Empower login
- Empower project and system access
Chapter 2
Accessing the Server

This chapter explains how to log in to the server to perform system administration tasks. This chapter includes information regarding:

- Logging in to the operating system
- Changing the Windows user accounts passwords
- Oracle accounts
- Changing the Oracle user accounts passwords
- Changing the Empower system user account password
- Logging out of the operating system

2.1 Logging In to the Operating System

To log in to Windows 2000:

2. Enter the user name, password, and domain of the account you want to use to log in to the server. Click OK.

2.1.1 Windows User Accounts

There are different user accounts available to use to access the Windows operating system.

- Administrator accounts
- User accounts

Use an Administrator account to log in to the server when you need to perform system administration tasks.

**Attention:** Use caution when you access Windows 2000 using the Administrator account. This account allows you unlimited access to the Empower and Windows files and directories on the server.

Use a regular user account to log in to the server when you are not performing system administration tasks.
Windows 2000 computer accounts and user accounts used with the Empower software must be members of the same domain relationship.

2.2 Changing the Windows User Accounts Passwords

Change the Windows user account passwords the first time you log in and regularly thereafter to maintain system security.

To change an account password:

1. Log in to Windows 2000 using the account that requires the password change.
2. Press Ctrl+Alt+Delete. The Windows Security dialog box appears (Figure 2-1).
3. Click Change Password. The Change Password dialog box appears (Figure 2-2).
2.3 Oracle Accounts

The Empower system allows you to log in to Oracle using any one of two accounts. The two internal Oracle accounts are:

- Sys
- System

Use the Oracle Sys account (user name = Sys, password = oracle) with database administrator (DBA) privileges to access the server when you want to use Oracle functions or commands that require internal-level access, such as shutting down the database instance.

Use the Oracle System account (user name = System, password = manager) to access the server when you want to use Oracle database functions or commands that require system-level access, such as taking the tablespace online or offline.

2.3.1 Logging In to an Oracle Account

Log in to the Sys account (with DBA privileges) by entering the following:

1. At the command prompt, enter `sqlplus /nolog`.
2. Enter `connect sys/oracle as sysdba`

When you are finished using the Oracle account, enter `exit` to exit SQL.

Log in to the System account by entering the following:

1. At the command prompt, enter `sqlplus /nolog`.
2. Enter `connect system/manager`

When you are finished using the Oracle account, enter `exit` to exit SQL.

2.4 Changing the Oracle User Accounts Passwords

Change the Oracle user account passwords the first time you log in and regularly thereafter to maintain system security.
To change the System account password:

1. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears.
2. Enter the following commands:
   
   `C:\> sqlplus /nolog
   SQL> connect sys/oracle as sysdba
   SQL> Alter user username identified by password;
   SQL> exit`

   *Note: password is the new password that you are defining.*

To change the Sys account password:

1. In Windows Explorer, rename the password file which is located in oracle_home\Database\PWDWATn.ora.
   
   *Note: Because the naming convention of some file names depends on the SID name chosen at installation, the variable n refers to the number within the SID name, where n can be 0 to 9 or A to Z. For example, a file name of Ctl2WAT5.ora corresponds to a SID name of WAT5. This variable is referred to throughout this guide.*

   oracle_home is in the registry under HKEY_LOCAL_MACHINE\Software\Oracle.

2. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears
3. Enter the following command:
   
   `C:\> ORAPWD
   FILE=program-drive:\EmpowerOra\Ora\Database\PWDWATn.ora
   PASSWORD=password ENTRIES=5`

   *Note: password is the new password that you are defining.*

2.5 Changing the Empower System User Account Password

Change the Empower system user account password the first time you log in and regularly thereafter to maintain system security

To change the System account password:

1. In Configuration Manager, select the Users view. In the right pane, select System.
2. Right-click System, then select Properties. In the General tab, enter the new password in the New Password and Confirm New Password fields. Click OK.
Note: You must be logged in as an Administrator to perform this procedure.

2.6 Logging Out of the Operating System

To prevent unauthorized use of the system, log out of the server when you are not actively using it. This is especially important when you are logged in with a Windows Administrator account.

To log out of the server:
1. Press Ctrl+Alt+Delete. The Windows Security dialog box appears (Figure 2-1).
2. Click Log Off.
Chapter 3
Managing the Server

This chapter provides the information you need to keep the Waters Empower server functioning properly. It covers the following topics:

- Starting the server
- Starting up and shutting down the Empower database
- Shutting down the Empower system
- Managing operating system and Oracle user accounts and passwords
- Archiving alert logs
- Organizing server storage
- Managing the server disk space
- Backing up and restoring server disk images
- Backing up the Empower database
- Restoring the Empower database
- Adding a listener service

Some topics are in the Empower Help. To avoid duplication, appropriate references to these topics are in this chapter.

3.1 Starting the Server

The Empower file services (provided by Waters) and the Empower database (provided by the Oracle software) start automatically when you power up the server and start Windows 2000. If you shut down the Oracle database manually, you need to start up the Oracle database manually.

This section presents the procedure to use when you start up the Empower server. To ensure that all Empower system components communicate properly with each other, power on the system devices and the server in the order specified in the following procedure.

To start the Empower system:

1. Power on any expansion boxes connected to the server. See the hardware manual for the particular device.
2. Power on the monitor.
3. Power on the server by pressing the system On/Off switch to the **On (1)** position. The system begins the self-test powerup sequence. See the server hardware manual for the power-up sequence for your particular server model.

4. After the hardware loading and initializing messages are complete, the Windows Welcome screen with the login message appears.

   **Note:** During the boot procedure, the database starts automatically. To manually start the database, see Section 3.2, Starting Up and Shutting Down the Empower Database.

5. In the Log On to Windows dialog box, enter the user name, password, and domain of the account you want to log in to on the server. See Section 2.1, Logging In to the Operating System.

### 3.2 Starting Up and Shutting Down the Empower Database

#### 3.2.1 Starting Up the Empower Database

For various reasons, the Empower database might need to be started manually. For example, the database needs to be manually started in order to perform database recovery or if the database fails to start when the server is rebooted.

To manually start the Empower database:

1. Verify that the OracleServiceWat*n* service is running by selecting **Start > Control Panel > Administrative Tools > Services**. If this service is not started, click **Start**.

   **Note:** Because the naming convention of some file names depends on the SID name chosen at installation, the variable *n* refers to the number within the SID name, where *n* can be 0 to 9 or A to Z. For example, a file name of Ctl2WAT5.ora corresponds to a SID name of WAT5. This variable is referred to throughout this guide.

2. Select **Start > Run**. In the Run dialog box, enter **CMD** and click **OK**. The Command Prompt window appears.

3. Enter the following commands:

   ```
   C:\> sqlplus /nolog
   SQL> connect sys/oracle as sysdba
   SQL> startup
   ```

4. Enter the following command:

   ```
   SQL> startup
   ```
5. To confirm that the Empower database is running, enter the following commands:

   SQL> select file_name, tablespace_name, bytes, status from dba_data_files;

   **Note:** If the database started successfully, all tablespaces are listed as available.

### 3.2.2 Shutting Down the Empower Database

For various reasons, the Empower database might need to be shut down. For example, the database needs to be shut down before performing a cold backup or before performing server maintenance. Before shutting down the Empower database, you might want to use System Monitor to confirm that no users are currently connected to the database. To start System Monitor, select View > System Monitor from the Configuration Manager window.

To manually shut down the Empower database:

1. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears.
2. Enter the following commands:

   C:\> sqlplus /nolog
   SQL> connect sys/oracle as sysdba
3. Enter the following command:

   SQL> shutdown transactional or shutdown immediate

   **Note:** The shutdown transactional command is safer but can take longer than the shutdown immediate command.

### 3.3 Shutting Down the Empower System

You might find it necessary to shut down the server or clients and chromatographic systems from time to time. For example, you need to shut down the server when you upgrade the server software, or possibly during an electrical storm. (To restart the server after a shutdown, see Section 3.1, Starting the Server.)

This section describes:

- Shutting down the server
- Shutting down the clients and chromatographic systems

#### 3.3.1 Shutting Down the Server

To shut down the server:

1. Ensure that all users are logged out of the Empower application on all clients.
Note: If any acquisition is in progress when the server is shut down, it will be buffered and then recovered when the server is back online.

2. At the server, manually shut down the Empower database:
   a. Select Start > Run. In the Run dialog box, enter cmd and click OK. The Command Prompt window appears.
   b. Enter the following commands:
      ```
      C:\> sqlplus /nolog
      SQL> connect sys/oracle as sysdba
      SQL> shutdown transactional or shutdown immediate
      SQL> exit
      ```
   c. Close the Command Prompt window, then select Start > Shut Down. Ensure that Shut down is selected, then click OK. The computer shuts down.

3. Power off the server by pressing the system On/Off switch to the Off (0) position.

4. Power off any expansion boxes (see the hardware manual for the particular device).

   Note: Wait at least 1 minute before powering on the server again.

3.3.2 Shutting Down the Clients and Chromatographic Systems

To shut down and power off the Empower clients and chromatographic systems:

1. Ensure that all data acquisition is complete and all users are logged out of the Empower application.
2. Using the remote application software, connect to each LAC/E32 Acquisition Server and shut it down.
3. Power off the LAC/E32 Acquisition Server.
4. Power off chromatographic instrumentation connected to the LAC/E32 Acquisition Servers.
5. Shut down client computers by selecting Start > Shut Down.
6. If applicable, power off chromatographic instrumentation that is connected to the client computers.
7. Power off other peripherals such as printers and modems.

3.4 Managing Operating System and Oracle User Accounts and Passwords

Adding and deleting accounts and changing account passwords is an ongoing activity that a system administrator needs to address for security and administration purposes.
See the *Windows Help* and *Oracle Help* for information on managing accounts and passwords.

**Note:** The Empower batch files used for database backup call four .sql files located in the Empower\script directory. The files are cs_begin_backup.sql, cs_end_backup.sql, cs_switch_logfile.sql, and cs_shutdown.sql. All these files use the password of the Oracle system or sys account. If the password is changed from the default password (manager and oracle, respectively), the .sql files must also be edited to incorporate the new password.

### 3.5 Archiving Alert Logs

The Oracle alert log is a file that Oracle uses to log important database information. As a result, this file continually increases in size. If the file becomes too large, it can affect system performance. You should archive your alert log on a regular basis so that it does not become too large.

To archive the alert log, move it from `oracle_home\RDBMS\trace\WATnALRT.log` to your storage location, i.e., G:\Backup.

**Note:** After the alert log is moved, a new one will be recreated automatically.

### 3.6 Organizing Server Storage

This section describes the storage organization of the Empower server and discusses server hard drives and database file organization.

#### 3.6.1 Server Hard Drive Organization

The default configuration of the Empower server uses four large-capacity hard drives that are partitioned into four logical drives for storing:

- The boot drive
- The Windows 2000 operating system
- Oracle program files, Empower client stack, and Empower scripts
- The Empower database
- Empower raw data files
Table 3-1 identifies a typical disk configuration and the content for the Empower server.

Table 3-1 Typical Server Disk Configuration

<table>
<thead>
<tr>
<th>Hardware Drive</th>
<th>Drive Letter</th>
<th>Drive Name</th>
<th>Volume Label</th>
<th>Type</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>C:</td>
<td>Operating System</td>
<td>System</td>
<td>NTFS</td>
<td>Boot files and Windows 2000 operating system</td>
</tr>
<tr>
<td>1</td>
<td>D:</td>
<td>Program Files</td>
<td>WAT_Prg</td>
<td>NTFS</td>
<td>Oracle (engine) executable software, Empower executables, Empower application client share, the Empower script directory, the Oracle home directory, and archive log files</td>
</tr>
<tr>
<td>2</td>
<td>E:</td>
<td>Empower Database</td>
<td>WAT_DB</td>
<td>NTFS</td>
<td>Initialization file (initWAT\n.ora), all database files (files that make up the database), the first mirrored redo logs, and the first mirrored control file (ctl1WAT\n.ora)</td>
</tr>
<tr>
<td>3</td>
<td>F:</td>
<td>Empower Raw Data</td>
<td>WAT_DF</td>
<td>NTFS</td>
<td>Empower raw data files, the second mirrored control file (ctl2WAT\n.ora)\n, and the second mirrored redo logs (redo20n.log, where n is 1 to 4)</td>
</tr>
</tbody>
</table>

a. Drive letters are for example only.
b. Volume labels are for example only.
c. In a Workgroup configuration, two hard drives (three logical hard drives) are used and the database and raw data are contained on the same drive.
d. \n refers to the character in the Oracle SID name. By default, this character is 5, although valid characters are 0 to 9 and A to Z.

Note: Redo logs are mirrored (by default) for data recovery.

3.6.2 Database File Organization

For detailed information on defining the basic database structure, see the Empower System Installation and Configuration Guide. The initWAT\n.ora file and other parameters used during instance creation define the Empower database. For both performance and reliability reasons, the Oracle archive logs, mirrored control files, and mirrored redo logs are usually located on different physical disks. These locations are defined when the database is generated.

The initWAT\n.ora file located in the database-drive:\Empower\Database directory contains the following information:
The location of the mirrored control files
The value of log_archive_dest, which is the location of the archive log files
The value of user_dump_dest, which is the location of the alert log file
The value of background_dump_dest, which is the location of the trace files
Oracle database parameters

For detailed information on the Oracle database files, see the Oracle9i Database Concepts Manual and the Empower System Installation and Configuration Guide.

The Empower database files are organized by default as shown in Table 3-2.

Table 3-2  Empower Default File Organization

<table>
<thead>
<tr>
<th>Drive</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>oracle_home\Database</td>
<td>pwdWATn.ora – The Oracle (not Empower) password file</td>
</tr>
<tr>
<td>oracle_home\Database\Archive</td>
<td>* .arc – The archive log files used for database recovery</td>
</tr>
<tr>
<td>program-drive\Empower</td>
<td>The Empower software executable files and scripts</td>
</tr>
<tr>
<td>program-drive\EmpowerOra\Ora</td>
<td>The Oracle software executable files</td>
</tr>
<tr>
<td>database-drive\Empower\Database</td>
<td>For a new installation or an upgrade by export/import:</td>
</tr>
<tr>
<td></td>
<td>• tmp1WATn.dbf – The initial temporary tablespace file</td>
</tr>
<tr>
<td></td>
<td>• idx1WATn.dbf – The initial index tablespace file</td>
</tr>
<tr>
<td></td>
<td>• usr1WATn.dbf – The initial user data (project) tablespace file</td>
</tr>
<tr>
<td></td>
<td>• initWATn.ora – The startup parameters file</td>
</tr>
<tr>
<td></td>
<td>• ctl1WATn.ora – One copy of the Oracle control file</td>
</tr>
<tr>
<td></td>
<td>• Redo0n.log – The redo log files (where n is 1 to 4)</td>
</tr>
<tr>
<td></td>
<td>• undo01.dbf – The initial undo tablespace file</td>
</tr>
<tr>
<td></td>
<td>• system01.dbf – The initial Oracle system tablespace file</td>
</tr>
<tr>
<td>rawdata-drive\Empower</td>
<td>ctl2WATn.ora – Second copy of the Oracle control file</td>
</tr>
<tr>
<td>rawdata-drive\Empower\Projects</td>
<td>redo20n.log – Copy of the redo log files (where n is 1 to 4)</td>
</tr>
</tbody>
</table>

This is the default raw data location. The location of raw data can be changed. Raw data belonging in different projects can also be stored in multiple locations. Each raw data path used has project subdirectories that contain the raw chromatographic data files using the following name format: Channel ID.dat.

a. oracle_home is in the registry under HKEY_LOCAL_MACHINE\Software\Oracle.
Note: Because the naming convention of some file names depends on the SID name chosen at installation, the variable \( n \) refers to the number within the SID name, where \( n \) can be 0 to 9 or A to Z. For example, a file name of Ctl2WA T5.ora corresponds to a SID name of WAT5. This variable is referred to throughout this guide.

3.7 Managing the Server Disk Space

The Operating System Disk Management Properties dialog box provides several tools to help you manage disk space. This section covers the following topics:

- Checking free disk space
- Increasing free disk space
- Defragmenting the hard disk

3.7.1 Checking Free Disk Space

To avoid hard disk problems and to maintain server performance, limit server hard drive use to no more than 80% of full capacity. The Windows operating systems provide utilities such as Windows Explorer, System Tools, Disk Management, and the Windows Help to help you manage server disk space.

Use the following procedure to check the free disk space on the server. In a standard configuration, disk space on the server is used mainly by raw data acquired with the Empower software. The size of raw data files created in Empower software is related to the sampling rate and the run time used to collect data. The database size also expands with usage.

In the Empower software, multiple raw data paths can be defined. It is therefore also necessary to check disk space on each drive where raw data is being stored. See Section 4.10, Managing Raw Data Files, for more information.

Attention: To avoid degradation in system performance, system administrators need to check available disk space at least once a day. On systems with heavy daily usage, check and record available disk space several times a day. If your system is used less frequently, check and record disk space accordingly.

To check free disk space on the server:

1. Select a drive using Windows Explorer.
2. Select File > Properties to open the System (C:) Properties dialog box. In the General tab (Figure 3-1), the Used space and Free space values are listed as well as the total capacity of the drive.
3. Verify available disk space and click **OK**.

**Note:** There are also utilities available to monitor and alarm or send an e-mail when disk space reaches a user-defined size.

### 3.7.2 Increasing Free Disk Space

You can increase free disk space by:
- Archiving projects
- Adding a hard disk
- Moving project raw data to another file share on a separate drive or server

**Archiving Projects**

Archiving projects involves:
1. Backing up projects
2. Deleting projects from the database

For details, see the procedures on archiving projects in the *Empower Help*.

**Note:** Waters offers an AutoArchive option for the Empower Software. This utility uses the Windows Scheduler to automate project backups and perform them on a regular;
user-defined basis. For more information, contact your local subsidiary or see www.Waters.com.

**Attention:** Before you delete the project, verify that no one else is using the project in the Users tab of System Monitor. Launch System Monitor from the Configuration Manager window.

### Adding a Hard Disk

Another way to increase free disk space is to add a hard disk to your Empower system. For information about adding a hard disk to your Empower system, see the hardware documentation and the Windows documentation that you received with your server.

### Moving Project Raw Data

Moving your raw data storage location to another computer or drive on your network allows you to add additional storage capacity. See Section 4.10, Managing Raw Data Files, for information on this procedure.

#### 3.7.3 Defragmenting the Hard Disk

Hard disk fragmentation occurs when you delete files from a disk and then create or add new files on the same disk. Fragmentation inevitably occurs when using a system. If left unchecked, disk fragmentation can slow system performance dramatically. The Windows 2000 operating system contains a defragment utility. To access this utility, select Start > Settings > Control Panel > Administrative Tools > Computer Management. The Disk Defragmenter utility is located under the Storage node of Computer Management. For information on using this utility, see the Windows 2000 Help.

#### 3.7.4 Defragmenting the Database

The Oracle database can become fragmented when you add and delete chromatograms, results, and methods. If left unchecked, database fragmentation can slow system performance dramatically.

This section describes how to use the Oracle EXP/IMP utilities to defragment the database. Defragmenting the database involves:

1. Checking for fragmentation
2. Exporting and deleting the Empower database
3. Creating the empty database instance
4. Importing the original Empower database

Managing the Server  43
5. Reenabling archive log mode

**Attention:** This procedure permanently deletes database table files. Before performing this procedure, ensure that you have a full cold backup of the entire system.

### Checking for Fragmentation

To check the database for fragmentation:

1. Select **Start > Run**. In the Run dialog box, enter **CMD** and click **OK**. The Command Prompt window appears.
2. Enter the following commands:
   ```
   C:\> sqlplus /nolog
   SQL> connect system/manager
   SQL> select file_ID, tablespace_name, bytes from dba_free_space;
   ```
   Each tablespace has one or more rows. This shows how free space in each tablespace is grouped into extents (an extent is a contiguous area on the disk and has the same file_id). Five or fewer extents per tablespace is ideal.
3. Enter the following command:
   ```
   SQL> select owner, segment_name, tablespace_name, bytes, extents from dba_segments where extents > 5;
   ```
   This shows how many extents each table occupies. Ideally, most tables should occupy five or fewer extents. If the tests reveal heavy fragmentation, you might want to degragment the drive when it is convenient to shut down your server.
4. If you need to degragment the database, enter the following command:
   ```
   SQL> select file_name, tablespace_name, bytes, status from dba_data_files;
   ```
   **Note:** In addition, if you have multiple data files per tablespace, enter the following command to determine the total tablespace in bytes:
   ```
   select tablespace_name, sum(bytes) from dba_data_files group by tablespace_name;
   ```
5. Record all information for later use. If the tablespace files have increased significantly, you might need to adjust their initial size and maximum size in cs_createdatabase.sql, in **program-drive\empower\script**.
6. Enter the command:
   ```
   SQL> exit
   ```
Exporting and Deleting the Empower Database

Attention: Make sure you have sufficient disk space before you perform this procedure.

To export the entire database:

1. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears.
2. Enter the command:
   
   C:\> exp system/manager

3. Press Enter, then respond to the prompts as follows:

   Array fetch buffer size: 4096 > 10000000
   Export file: EXPDAT.DMP > fullDB.dmp
   (1) E(ntire database), (2) U(sers), or (3) T(ables):
       (2) U > E

   Accept default values for the remaining prompts by pressing Enter after each prompt:

   Export grants (yes/no) : yes >
   Export table data (yes/no): yes >
   Compress extents (yes/no): yes >

   The database is exported.

4. Shut down the database by entering the following commands:

   C:\> sqlplus /nolog
   SQL> connect sys/oracle as sysdba
   SQL> shutdown immediate (or shutdown transactional)
   SQL> exit

   Attention: The next two steps permanently delete the Empower database. Waters strongly recommends that you have a complete cold backup before performing steps 5 and 6.

5. Delete the instance:
   
   C:\> oradim -delete -sid WATn

6. Delete the database files:
   
   a. Delete all files in the database-drive: \empower\database directory except initWATn.ora.
   
   b. Delete the file rawdata-drive: \empower\ctl2WATn.ora and rawdata-drive: \Empower\redo20n.log, where n is 1 to 4.)
Note: The variable \textit{n} refers to the number in the SID name, where \textit{n} can be 0 to 9 or A to Z. This variable is referred to throughout this guide.

7. Reboot the server.

\textbf{Creating the New Database Instance}

Use script files to create the Empower database instance.

\textbf{Attention:} Before continuing, verify that you have enough tablespace to handle the database import and future storage requirements by editing \texttt{cs\_createdatabase.sql} in the program-drive:\empower\script directory. Refer to the tablespace value recorded in step 5 of "Checking for Fragmentation" in Section 3.7.4, Defragmenting the Database.

To create a new database instance:

1. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears.

   \textbf{Note:} This example assumes that disk drive D: is the Empower program directory. Use the actual program directory for your server.

2. Enter the following commands to build the new database:

   \begin{verbatim}
   C:\> program-drive:
   D:\> cd empower\script
   D:\empower\script> cs_createinstance.bat
   D:\empower\script> cs_builddb.bat
   D:\empower\script> exit
   \end{verbatim}

\textbf{Importing the Empower Database}

To import the database:

1. Enter the following command:

   \texttt{C:\> imp system/manager}

2. Press Enter, then respond to the prompts as follows:

   \begin{verbatim}
   Import file: c:\fullDB.dmp
   Array fetch buffer size: 10000000
   List contents of import file only (yes/no): no > n
   Ignore create error due to object existence (yes/no): no > y
   Import grants (yes/no): yes > y
   Import table data (yes/no): yes > y
   Import entire export files (yes/no): no > y
   \end{verbatim}

   \textbf{Note:} The import utility reports errors that are caused by the Oracle data dictionary that exists in both the import file and the new database.
3. Reboot the server, then connect a client.
4. Verify that the database is running properly.

   **Note:** In step 2, the import file name must refer to the path that was used during the database export in "Exporting and Deleting the Empower Database" on page 45.

### Enable Archive Log Mode

After importing the database, you must reenable archive log mode.

To enable archive log mode:

1. Use Notepad to edit `database-drive:\Empower\database\initwatin.ora`. Remove the comment symbol (#) from the following command in this file:
   
   ```
   #log_archive_start = true
   ```
2. Save the `initwatin.ora` file and exit.

   **Note:** The variable `n` refers to the number in the SID name, where `n` can be 0 to 9 or A to Z. This variable is referred to throughout this guide.

3. Select **Start > Run**. In the Run dialog box, enter **CMD** and click **OK**. The Command Prompt window appears.
4. Enter the following commands:
   ```
c:\> sqlplus /nolog
SQL> connect sys/oracle as sysdba
SQL> shutdown immediate
SQL> startup mount
SQL> alter system archive log start;
SQL> alter database archivelog;
SQL> alter database open;
SQL> archive log list
```
Verify that database log mode is Archive Mode and that automatic Archival is enabled.
5. Enter the following command:
   ```
   SQL> alter system switch logfile;
   ```
6. Look for archive log files (ending in .arc) in the archive log directory with recent date and time stamps. The archive log directory is defined in the `initwatin.ora` file, by the line that reads `log_archive_dest =`.
7. At the **SQL>** prompt, enter **exit**.
3.8 Backing Up and Restoring Server Disk Images

You can back up and restore server disks of a database (whole disk images) on tape using Windows 2000 Backup, or a third-party backup suite or tool.

Before backing up or restoring a disk image, shut down the database and stop the OracleServiceWATn service, the Waters Service, and the Oracle listener service.

See the Windows operating system documentation and Windows Help.

**Attention:** Do not back up or copy open database files using anything other than Waters’ backup scripts. Waters’ scripts use Oracle utilities to back up open database files. You must use these or similar tools to back up open database files or the disk images generated by the backup will not properly recover the system.

**Background Information**

To properly safeguard your Empower Enterprise or Workgroup system, you must perform complete backups of all disks (a whole disk image) on a regular basis. You can use these backups to restore the server to a previous state in the event of a catastrophic disk failure without reloading software.

**When to Back Up the Server Disks**

Backing up server disks is a routine task. Your backup schedule depends on your company’s protocols and requirements. Waters recommends that you back up the entire server at least once a week.
Rotating Media

Use three or more sets of media for backups. Rotate the sets of media in sequence. For example, on Monday through Saturday, perform hot backups using six tapes that are rotated from week to week and on Sunday, perform a full backup (with the database shut down) using a new tape. Store the full backup tapes for as long as necessary (Table 3-3).

Table 3-3  Tape Rotation Schedule

<table>
<thead>
<tr>
<th>Week #</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
<th>Saturday</th>
<th>Sunday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week 1</td>
<td>Tape 1</td>
<td>Tape 2</td>
<td>Tape 3</td>
<td>Tape 4</td>
<td>Tape 5</td>
<td>Tape 6</td>
<td>Tape 7</td>
</tr>
<tr>
<td>Week 2</td>
<td>Tape 1</td>
<td>Tape 2</td>
<td>Tape 3</td>
<td>Tape 4</td>
<td>Tape 5</td>
<td>Tape 6</td>
<td>Tape 8</td>
</tr>
<tr>
<td>Week 3</td>
<td>Tape 1</td>
<td>Tape 2</td>
<td>Tape 3</td>
<td>Tape 4</td>
<td>Tape 5</td>
<td>Tape 6</td>
<td>Tape 9</td>
</tr>
<tr>
<td>Week 4</td>
<td>Tape 1</td>
<td>Tape 2</td>
<td>Tape 3</td>
<td>Tape 4</td>
<td>Tape 5</td>
<td>Tape 6</td>
<td>Tape 10</td>
</tr>
</tbody>
</table>

Store your backups appropriately. Replace your backup media on a regular basis. The lifespan of magnetic media is not infinite and it will wear out and become unreliable over time.

Testing Your Backups

Periodically test your sets of backup media to ensure that the backups are working correctly, in accordance with your company’s standard protocols for failure recovery.

Shutting Down the Database

See Section 3.2.2, Shutting Down the Empower Database.

Stopping the OracleServiceWA T n Service

Open the Administrative Tools applet in Control Panel. Open the Computer Management applet and then expand the Services and Applications node. Select Services and locate OracleServiceWA T n. Select Action > Stop.

Back Up or Restoring the Server Disk Image

To access the Backup Utility, select Start > Programs > Accessories > System Tools > Backup.
For more information on this utility, see the *Windows 2000 Help*.

**Attention:** Unless the database was shut down during the backup, you cannot use the disk images generated by these backup utilities to recover a running Oracle database because the internal Oracle files will not be properly synchronized. A disk image can be used to recover software applications and the operating system, including users and profiles. Waters recommends that you use the Empower backup scripts to back up the database, as described in the next section.

### 3.9 Backing Up the Empower Database

This section describes the procedures for backing up the Empower database using the backup script files provided by Waters. This section covers the following topics:

- Performing a hot database backup to drive
- Performing a hot database backup to tape
- Performing a cold database backup to drive
- Performing a cold database backup to tape

Oracle also provides various templates for backing up and restoring a database, or for running scripts to back up and restore files. As a knowledgeable system administrator, you might want to use your own backup variation.

**Note:** When executing backup scripts, do not use a storage-directory that contains spaces in its name. (This is true for the cs_hottape.bat temporary disk location and for the destination of the cs_colddrive.bat and cs_hotdrive.bat scripts.)

**Backup Schedule**

To protect Empower data, Waters recommends that you perform:

- A cold backup of the database and the Empower raw data files at least once a week
- A hot backup of the database and the Empower raw data files at least once a day
**Backup Script Files**

**Attention:** Determine the frequency of backing up based on the relative importance of your data. If you are working with critical data, you might want to back up your files more than once a day, or back up individual projects using the Empower backup tools.

Table 3-4 describes the available Empower database backup script files.

<table>
<thead>
<tr>
<th>Backup Script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cs_hotdrive.bat</td>
<td>Backs up database files, archive log files, and raw data files to a backup disk drive.</td>
</tr>
<tr>
<td></td>
<td>• A backup to drive is faster than a backup to tape.</td>
</tr>
<tr>
<td></td>
<td>• The database is running during the backup.</td>
</tr>
<tr>
<td></td>
<td>• Using this script, you can easily back up to a directory that is subsequently backed up as part of the corporate backup strategy.</td>
</tr>
<tr>
<td></td>
<td>• Of all the different types of backup, this one requires the most disk space because the entire database, the archive logs, and all raw data files are backed up to the storage directory on the storage disk.</td>
</tr>
<tr>
<td></td>
<td>• Backing up is relatively fast.</td>
</tr>
<tr>
<td>cs_hottape.bat</td>
<td>Backs up database files, archive logs and raw data files to tape.</td>
</tr>
<tr>
<td></td>
<td>• The database is running during the backup.</td>
</tr>
<tr>
<td></td>
<td>• This script backs up database files to temporary disk drive before backing them up to tape.</td>
</tr>
<tr>
<td></td>
<td>• This script backs up raw data files directly to tape.</td>
</tr>
<tr>
<td></td>
<td>• Less disk space is required than with a hot backup to drive because only the database (not the raw data files) is backed up to the storage directory on the storage disk before it is copied to the tape.</td>
</tr>
</tbody>
</table>
Table 3-4 Database Backup Scripts (Continued)

<table>
<thead>
<tr>
<th>Backup Script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cs_colddrive.bat</td>
<td>Backs up database files and raw data to a specific drive.</td>
</tr>
<tr>
<td></td>
<td>• A backup to drive is faster than a backup to tape.</td>
</tr>
<tr>
<td></td>
<td>• The database is shut down by the script before the backup.</td>
</tr>
<tr>
<td></td>
<td>• The files are copied directly to the drive and the archive logs are deleted.</td>
</tr>
<tr>
<td></td>
<td>• This script allows the use of third-party backup applications.</td>
</tr>
<tr>
<td></td>
<td>• Using this script, you can easily back up to a directory that is subsequently backed up as part of the corporate backup strategy.</td>
</tr>
<tr>
<td></td>
<td>• The second control file (ctl2WATn.ora) and the mirrored redo logs (redo20n.log, where n is 1 to 4) are copied from rawdata-drive:\Empower to database-drive:\Empower\Database.</td>
</tr>
<tr>
<td></td>
<td>• The database is restarted by the script after the backup is complete.</td>
</tr>
<tr>
<td></td>
<td>• Backing up is relatively fast when using this script.</td>
</tr>
<tr>
<td></td>
<td>• This type of backup is the most reliable because the database is static.</td>
</tr>
<tr>
<td>cs_coldtape.bat</td>
<td>Copies the contents of directory database-drive:\Empower\Database to tape.</td>
</tr>
<tr>
<td></td>
<td>• The database is shut down by the script before the backup.</td>
</tr>
<tr>
<td></td>
<td>• The smallest physical disk space is used because the backup is not copied to the hard drive first.</td>
</tr>
<tr>
<td></td>
<td>• The second control file (ctl2WATn.ora) and the mirrored redo logs (redo20n.log, where n is 1 to 4) are copied from rawdata-drive:\Empower to database-drive:\Empower\Database so they can be backed up in one backup set.</td>
</tr>
<tr>
<td></td>
<td>• The database is restarted by the script after the backup is complete.</td>
</tr>
<tr>
<td></td>
<td>• This type of backup is the most reliable because the database is static.</td>
</tr>
</tbody>
</table>

**Considerations**

Before you back up the database, consider the following:

- Be aware of the different disk space storage requirements for each script.
When executing backup scripts, do not use a *storage-directory* that contains spaces in its name. (This is true for the cs_hottape.bat temporary disk location and for the destination of the cs_colddrive.bat and cs_hotdrive.bat scripts.)

If you manually relocate or add any Oracle files, you must modify the backup scripts accordingly to indicate the new location.

If Empower software is running, and a file is in use, it cannot be backed up.

You can back up archive log (*.arc) files while Oracle is running.

The backup batch files that Waters provides can be run either from the command prompt or by using a scheduling program so that they can be run at regular times.

If you change your raw data paths (see Section 4.10, Managing Raw Data Files), you must modify your backup scripts to capture this data.

**Attention:** The Empower batch files call four .sql files in the Empower\script directory. The files are cs_begin_backup.sql, cs_end_backup.sql, and cs_switch_logfile.sql (called by hot backups); and cs_shutdown.sql (called by cold backups). All these files use the password of the Oracle system or Sys account. If the password is changed from the default password, the .sql files must also be edited to change the password.

**Attention:** The cs_begin_backup.sql and cs_end_backup.sql files are called to put all the database tablespaces into and out of backup mode. If a new tablespace data file is added, these files must be edited to add the new datafile to the lists; otherwise, it will not be backed up.

**Media Pool Name**

When performing a hot or cold backup to tape using Windows 2000, the command syntax requires you to use the tape drive's media pool name.

To determine your tape drive's media pool name:

1. Select **Start > Run**. The Run dialog box appears.
2. Enter `ntbackup`. The Backup dialog box appears.
3. Click the **Backup** tab. The available media pool names are listed in the Backup destination list (Figure 3-2).
3.9.1 Performing a Hot Backup to Drive

The cs_hotdrive.bat file performs a hot backup to a hard disk drive. The command syntax for using this script file is:

```
C:\> program-drive:\Empower\Script\cs_hotdrive
storage-disk:\storage-directory
```

`storage-disk` and `storage-directory` specify the location where the backup is to be placed.

For example, to perform a hot backup to drive:

1. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears.
2. Enter the following command:
   
   ```
   C:\> program-drive:\Empower\Script\cs_hotdrive.bat G:\Backup
   ```
3. To schedule a hot backup to a drive to occur at 12:00 midnight using an AT command:
   
   ```
   C:\> AT 12:00AM D:\Empower\Script\cs_hotdrive.bat G:\Backup
   ```

You should now back up the \Backup folder using Windows 2000 Backup, or a third-party backup application.

Figure 3-2  Windows 2000 Media Pool Names
3.9.2 Performing a Hot Backup to Tape

The cs_hottape.bat file performs a hot backup to a tape drive. The command syntax for using this script file is:

C:\> D:\Empower\Script\cs_hottape.bat media-pool-name
storage-disk:\storage-directory

storage-disk and storage-directory specify the location where the backup is to be placed.

For example, to perform a hot backup to tape using Windows 2000:

1. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears.
2. Enter the following command:
   C:\> D:\Empower\Script\cs_hottape.bat dlt G:\Backup

3.9.3 Performing a Cold Backup to Drive

The cs_colddrive.bat file performs a cold backup to a hard disk drive. The command syntax for using this script file is:

C:\> D:\Empower\Script\cs_colddrive
storage-disk:\storage-directory

storage-disk and storage-directory specify the location where the backup is to be placed.

For example, to perform a cold backup to a drive:

1. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears.
2. Enter the following command:
   C:\> D:\Empower\Script\cs_colddrive.bat G:\Backup

   You should now back up the \Backup folder using Windows 2000 Backup or a third-party backup application.

3.9.4 Performing a Cold Backup to Tape

The cs_coldtape.bat file performs a cold backup of the database and raw data files to a tape drive.

Note: The cold backup script overwrites all information on the tape.

The command syntax for using this script file is:

C:\> D:\Empower\Script\cs_coldtape media-pool-name
For example, to perform a cold backup to tape using Windows 2000:

1. Select **Start > Run.** In the Run dialog box, enter **CMD** and click **OK.** The Command Prompt window appears.
2. Enter the following command:
   
   ```
   C:\> D:\Empower\Script\cs_coldtape.bat dlt
   ```

### 3.10 Restoring the Empower Database

This section covers:

- Backup set structures
- Recovering from an Empower database drive failure
- Recovering from an Empower raw data drive failure
- Recovering from an Empower program files disk failure
- Recovering from an Empower database drive and raw drive failure
- Unusual recovery conditions

**Note:** If you have changed your raw data paths from the default of `rawdata-drive:\Empower\Projects` (see [Section 4.10, Managing Raw Data Files](#)), during database recovery you must copy the data to the appropriate location.

When regular backups of the database are performed, you can restore the database in case of a hard disk crash. Restoring the database involves:

- Repairing the hardware failure
- Logging in with the Administrator account
- Restoring the files

This section assumes that:

- All Oracle Empower database files are on one drive (not divided among several drives)
- All Empower raw data files are in the default location `rawdata-drive:\Empower\Projects`

**Attention:** If the database files are not on one drive, you will have to restore these files to their original locations.

Database recovery using a hot backup is done using the Oracle Recover command. This command is invoked through the SQLPlus function in a Command Prompt window. Use
the procedures in this section to restore the Empower and Oracle data that you backed up using the procedures in Section 3.9, Backing Up the Empower Database.

Note: The most common failure that results in data loss is a hard disk failure. RAID technology can protect against data loss even in the event of a hard disk failure.

3.10.1 Backup Set Structures

Each backup technique (hot drive backup, hot tape backup, cold drive backup, or cold tape backup) that you use to back up the Empower database results in a specific backup set structure. When you restore the database from one of these backups, it is important to be familiar with its specific backup set structure. This section describes:

- Hot drive backup set structure
- Hot tape backup set structure
- Cold drive backup set structure
- Cold tape backup set structure

**Hot Drive Backup Set Structure**

A hot drive backup creates a hot backup folder on the selected drive that has the following structure:

- Archive folder containing the archive (.arc) log files
- Database folder containing the database files, the Oracle password file, and the mirrored control and redo log files
- Projects folder containing the project raw data files (with each project in its own folder)
See Figure 3-3 for an example of a hot drive backup set structure.

**Hot Tape Backup Set Structure**

A hot backup to tape creates at least two backup sets on the selected tape drive structured as follows:

- The first backup set contains all Empower projects and associated raw data files (with each project in its own folder).
- The second backup set contains the database files, the Oracle password file, mirrored control file, mirrored redo logs, and an archive folder containing the archive (.arc) log files.
See Figure 3-4 for an example of a hot tape backup set structure.
Cold Drive Backup Set Structure

A cold drive backup creates a cold backup folder on the selected drive that has the following structure:

- Database folder containing the database files, the Oracle password file, and the mirrored control and redo log files
- Projects folder containing the project raw data (with each project in its own folder)

**Note:** Archive log files are not required for cold backup recovery. However, archive log files are required for hot backup recovery. The cold backup scripts contain commands that allow you to back up the archive logs. These commands are normally remarked (have a “rem” preceding the command) and therefore do not execute. If your main strategy uses hot backups, you might want to remove the “rem” before these commands so that archive logs are backed up when performing a cold backup.

See **Figure 3-5** for an example of a cold drive backup set structure.

![Figure 3-5 Cold Drive Backup Set Structure](image)

Cold Tape Backup Set Structure

A cold backup to tape creates two backup sets on the selected tape drive structured as follows:

- The first backup set contains all Empower projects and associated raw data files (with each project in its own folder).
• The second backup set contains the database files and the mirrored control and redo log files.

**Note:** Archive log files are not required for cold backup recovery. However, archive log files are required for hot backup recovery. The cold backup scripts contain commands that allow you to back up the archive logs. These commands are normally remarked (have a "rem" preceding the command) and therefore do not execute. If your main strategy uses hot backups, you might want to remove the "rem" before these commands so that archive logs are backed up when performing a cold backup.

See **Figure 3-6** for an example of a cold tape backup set structure.

![Figure 3-6 Cold Tape Backup Set Structure, Windows 2000](image)

### 3.10.2 Recovering from an Empower Database Drive Failure

**Overview**

This section describes recovering files only in the `database-drive:\Empower\Database` directory. To recover other files or directories, you need to use other means. Loss of other drives or directories can require additional recovery procedures.

**Attention:** *Ensure that the hardware failure is repaired before you perform this procedure.*
Restoring Empower Database Files from a Hot Backup

**Attention:** Restoring the Empower database using a hot backup requires the archive log files, a current copy of the redo log files, and the control file from the time of the database failure. (Only one copy of the mirrored redo log files and the control file is required.)

Before you restore the Empower database files from a hot tape or drive backup:

1. Log in to Windows 2000 as the administrator.
2. If the database is running, shut down the database as described in Section 3.2, Starting Up and Shutting Down the Empower Database.

**Attention:** Waters strongly recommends performing a disk image backup of all other drives before restoring (see Section 3.8, Backing Up and Restoring Server Disk Images), in case any files are inadvertently deleted or overwritten.

To access the backup sets, see Section 3.10.1, Backup Set Structures.

To restore the Empower Database directory:

1. Create the Empower directory under the root of the database drive, then create the database subdirectory under the Empower directory.
2. From the hot backup (tape or drive), copy all database files:
   - From tape, restore the contents of the database_backup directory (see Figure 3-4) to the database-drive:\Empower\Database directory.
   - From drive, copy the contents of the Database directory (see Figure 3-3) to the database-drive:\Empower\Database directory.
3. Delete the redo log files (redo01.log, redo02.log, redo03.log, and redo04.log) and control files (ctl1\WA\n.ora) in the new Database directory.
4. Copy the mirrored control file (ctl2\WA\nt.ora) from rawdata-drive:\Empower to database-drive:\Empower\Database, then rename it ctl1\WA\nt.ora.
5. Copy the mirrored redo logs (redo20\n.log, where \n is 1 to 4) from rawdata-drive:\Empower to database-drive:\Empower\Database. Rename the logs from redo20\n.log to redo01.log.
6. From the hot backup (tape or drive), copy all archive log files in the archive directory to the location defined by the log_archive_dest parameter in the init\WA\nt.ora file in the database-drive:\Empower\Database directory (see Section 3.6.2, Database File Organization).
   - See Figure 3-4 if restoring from tape.
   - See Figure 3-3 if restoring from the hard drive.

In the Command Prompt window, enter the commands:
C:\> sqlplus /nolog
SQL> connect sys/oracle as sysdba
SQL> shutdown immediate
SQL> set autorecovery on
SQL> startup
SQL> recover
SQL> alter database open;
SQL> exit

Note: The variable n refers to the number in the SID name, where n can be 0 to 9 or A to Z. This variable is referred to throughout this guide.

7. Immediately, shut down the Oracle database and perform an image backup of the entire database drive or perform a cold tape or cold drive backup.

Restoring Empower Database Files from a Cold Backup

Note: A cold backup restores your database to its state at the point of your last backup. To ensure that the raw data files are synchronized with the database, restore the raw data files that were backed up at the time of the cold backup.

When accessing the backup sets, see "Cold Tape Backup Set Structure" on page 60.

To restore the Empower database files from a cold backup on tape:

1. Using Windows 2000 Backup or another backup tool, restore all files in the Database directory to their original location.

   Attention: Copy the mirrored control files (ctl2WATn.ora) and the mirrored redo log files (redo20n.log, where n is 1 to 4) to another location. They can be used for additional recovery. The additional recovery is not covered in this procedure.

2. Copy the mirrored control file (ctl2WATn.ora) from database-drive\Empower\Database to rawdata-drive\Empower.

3. Copy the mirrored redo log files (redo20n.log, where n is 1 to 4) from database-drive\Empower\Database to rawdata-drive\Empower (overwrite the existing files with the same names).

4. Reboot the computer.

3.10.3 Recovering from an Empower Raw Data Drive Failure

The Empower raw data disk contains the raw chromatographic files and the mirrored copy of the control file (ctl2WATn.ora) and redo log files (redo20n.log, where n is 1 to 4). In this
situation, you do not lose Empower database information, because the Empower database disk remains intact.

**Attention:** Because chromatographic files produced between the last backup and the time of a disk failure are not recoverable, you cannot review or otherwise use chromatograms acquired or their results during that time period. However, all methods created or edited, sample loading information and results generated since the last backup will be available.

**Restoring Files and Directories**

If you have a current image backup of the Empower raw data disk, restore the disk image before you continue with this section. This restores any non-Empower-related data you might have placed on the disk.

To access the backup sets, see Section 3.10.1, Backup Set Structures.

To restore after a raw data drive failure:

1. Shut down the database.
2. Select Start > Run. In the Run dialog box, enter CMD and click OK. The Command Prompt window appears.
3. Enter the following commands:
   
   ```
   C:\> sqlplus /nolog
   SQL> connect sys/oracle as sysdba
   SQL> shutdown transactional or shutdown immediate
   SQL> exit
   ```

   **Note:** The shutdown transactional command is safer but can take longer than the shutdown immediate command.

4. Restore using your latest backup:

   - From hot or cold tape, restore the Empower Projects tree (see Figure 3-4).
   - From hot drive, create the Empower directory under the root of the raw data drive, then create the Projects subdirectory under the Empower directory (see Figure 3-3). From the backup drive, copy all project folders to the newly created Projects subdirectory.

5. Copy the mirrored control file (ctl1WATn.ora) from database-drive:\Empower\Database to rawdata-drive:\Empower.

6. In the rawdata-drive:\Empower directory, rename ctl1WATn.ora to ctl2WATn.ora.

7. Copy the redo log files (redo0n.log, where n is 1 to 4) from database-drive:\Empower\Database to rawdata-drive:\Empower.

8. In the rawdata-drive\Empower directory, rename the redo log files to redo201.log, redo202.log, redo203.log, and redo204.log, respectively.
9. In a Command Prompt window, enter the following commands to start the database:

```
C:\> sqlplus /nolog
SQL> connect sys/oracle as sysdba
SQL> shutdown immediate
SQL> startup
SQL> exit
```

### 3.10.4 Recovering from an Empower Program Files Disk Failure

The Empower Program Files disk contains the Empower client stack (in the Empower\Client directory), the Empower\Script directory, and the Oracle directory `oracle_home`, including the Oracle password file (pwdWATn.ora) and the Archive subdirectory containing archive log files and Net configuration files (TNSNames.ora and SQLNet.ora). Recovering this disk involves reinstalling Empower and Oracle.

In the case of partial disk failure (such as bad data sectors), where all archive (*.arc) files can be saved from the disk, back up the database drive immediately. The archive files can then be copied to a tape or network drive before the disk is repaired. This allows restoration of the database to the state at the time of failure.

If the database is running, shut down the database (see Section 3.2.2, Shutting Down the Empower Database).

**Note:** Waters strongly recommends performing a disk image backup of all other drives (see Section 3.8, Backing Up and Restoring Server Disk Images), in case any files are inadvertently deleted or overwritten. Ensure that the target directories have sufficient disk space to copy the files.

To access the backup sets, see Section 3.10.1, Backup Set Structures.

**Attention:** Be careful not to delete any archive log files that exist only on the server hard drive and are not backed up.

The best option is to restore a disk image backup of the entire drive, if available. If a disk image backup of the Program Files disk is not available, or your backup does not include the latest changes, then Empower and Oracle must be reinstalled as follows:

1. Shut down the database by entering the following in a Command Prompt window:

```
C:\> sqlplus /nolog
SQL> connect sys/oracle as sysdba
SQL> shutdown transactional or shutdown immediate
SQL> exit
```

If the database is not running, these commands will not work. Proceed to the next step whether or not these commands executed properly.
Note: The shutdown transactional command is safer but can take longer than the shutdown immediate command.

   
   Note: oracle_home is in the registry under HKEY_LOCAL_MACHINE\Software\Oracle.

3. Run Setup from the Empower CD, then perform an upgrade as requested by the Install wizard.

4. Restore the pwdWA Tn.ora file from the database location of the last hot drive or tape backup. Restore the file to the oracle_home\Database directory.

5. Restore TNSNames.ora and SQLNet.ora files to the oracle_home:\Network\Admin folder.

6. Perform a cold backup, as described in Section 3.9.4, Performing a Cold Backup to Tape.

3.10.5 Recovering from a Database and Raw Data Drive Failure

If both the Empower database drive and the Empower raw data drive fail, the mirrored control files become unrecoverable. This situation requires that you restore using a cold backup.

Attention: If you have only performed hot backups, recovery is possible. This requires, however, a more involved recovery procedure that is beyond the scope of this book.

To restore after a database and raw data drive failure:

1. Follow the steps in “Restoring Empower-Database Files from a Cold Backup” in Section 3.10.2, Recovering from an Empower Database Drive Failure.

2. Follow the steps in Section 3.10.3, Recovering from an Empower Raw Data Drive Failure (using a cold tape backup).

3.10.6 Unusual Recovery Conditions

Use this procedure to recover the database when a complete recovery has failed.

If archive log files are missing or redo logs are not current, you can recover up to the most recent complete transaction in your archive log files. For example, if your most recent backup tape is damaged, you can recover up to the date of your previous backup. In this case, add the words until cancel to your recover statement. For example, type one of the following recover statements as appropriate:
When you subsequently open the database, enter `alter database open resetlogs;` to reset the log counts. Then shut down the database and immediately perform a full cold database backup.

**Attention:** Using the `alter database open resetlogs` command prevents any future database recovery using the existing archive logs. Shut down the database and immediately perform a full cold database backup after using this command.

### 3.11 Configuring a Listener Service

You must configure listener services on the server to provide adequate connection performance between the server and your clients and LAC/E32 Acquisition Servers. As a general rule, configure one listener service for every 20 clients on your system. If client computers are added to your system after the original installation, you might need to configure additional listener services.

To configure a listener service:

1. Select **Start > Programs > Empower > Oracle > Oracle Net Configuration Assistant**. The Oracle Net Configuration Assistant: Welcome page appears (Figure 3-7).
2. Click **Listener configuration**, then click **Next**. The Listener Configuration, Listener page appears.
3. Select **Add**, then click **Next**. The Listener Configuration, Listener Name page appears (Figure 3-8).

![Figure 3-8 Listener Configuration, Listener Name Page](image)

4. Enter a listener name (other than Listener), then click **Next**. The Listener Configuration, Select Protocols page appears.
5. Ensure that TCP is listed in the Selected Protocols list, then click Next. The Listener Configuration, TCP/IP Protocol page appears (Figure 3-9).

![Figure 3-9 Listener Configuration, TCP/IP Protocol Page](image)

6. Click the Use another port number option button and enter the next available port number. Click Next. The Listener Configuration, More Listeners? page appears.

7. Do one of the following:
   - If you are done configuring listeners, click No. The Listener Configuration, Select Listener page appears (Figure 3-10). Complete steps 7 to 10.
   - If you need to configure another listener, click Yes and go to step 11.
8. Select the listener that you just created, then click **Next**. The Listener Configuration Done Page appears.

9. Click **Next**. The Welcome page of the Net Configuration Assistant Wizard appears.

10. Click **Finish**.

11. If you chose Yes in step 7, the Listener Configuration, Listener page reappears.

12. Repeat steps 3 to 7.

**Note:** To take advantage of the added listener, you must reconfigure your clients and LAC/E Acquisition Servers with the appropriate port numbers. See Section 4.2, *Configuring a Database Service Name*.
Chapter 4
Managing the Clients

This chapter describes how to manage the Empower clients and to perform the following tasks:

- Adding a client workstation
- Configuring a database service name
- Registering Acquisition Server printers
- Deleting a client workstation or LAC/E32 Acquisition Server
- Starting and logging in to the Empower software
- Logging out of the Empower software
- Managing user types
- Managing user accounts
- Managing user groups
- Managing raw data files
- Copying preferences
- Managing database properties
- Managing tablespaces
- Backing up and restoring projects
- Using System Monitor

Note: If you are logged in to the Empower software and then you log out of the software and leave some Empower applications running (such as Configuration Manager), a Running Empower Applications message box appears. This message box reminds you that you still have Empower applications open and allows you to leave them in a locked or an unlocked state. If you leave them in an unlocked state, a nonprivileged user can log in and use the open applications on your behalf. This user will have your access privileges even if his or her user type does not grant the user these privileges.

When performing administrative tasks on a client, you should use the Empower Pro interface.
4.1 Adding a Client Workstation

Use this section to add a new client workstation to the Empower Enterprise client/server system or Empower Workgroup configuration. The Empower software is required on each client that will be accessing the Empower database. The Empower software is installed from the shared client directory on the server.

4.1.1 Before You Begin

Before you add a client workstation to the network, ensure that the PC meets the minimum hardware and software requirements specified in the Empower Software Release Notes and that the client is active on the Empower network.

Note: Empower Software Release Notes are provided in the software kit with each version of Empower software. They are also available on the Waters Web site at www.Waters.com in the Connections Elite Support area.

4.1.2 Installing the Empower Client Software

You need to install the Empower software on any computer that will be used to run the Empower software and access the Empower database. To install the client software, map a network drive to the shared client directory on the server. Run the Setup.exe file to start the Empower Setup program. This program copies the software from the server and installs it on the hard disk of the client.

For details about installing the Empower software on clients, see the Empower System Installation and Configuration Guide, Chapter 5, Installing a Client.

Attention: After you install the Empower software, do not copy the Empower files to a different disk or directory. The client software must remain in the original path in order for it to function properly. If you need to move the Empower files to another disk after you install the software, use the Windows Add/Remove programs in the Control Panel to uninstall the current Empower installation and then reinstall the software to the new disk. See the Empower System Installation and Configuration Guide, Chapter 5, Installing a Client.

Empower Menu Items

After the Empower setup is complete, an Empower program folder containing menu items is created (Figure 4-1). This contains:

- Oracle – Allows you to configure a net service name.
- Empower Help – Allows access to the Empower Help.
- Empower Login – Allows access to the Empower software.
• File Verification Results – Allows you to view the Verify Files utilities’ checksum results.
• Installation Log – Allows you to view the installation log.
• Read Me! – Allows access to the Empower Read Me file.
• Register Acquisition Server Printers – Allows you to register printers when you are using run and report and background processing.
• Verify Files – Allows you to run a checksum test on the Empower software files to determine if any of these files have changed. The results of this test are reported in a file named checksum.txt and can be viewed with the File Verification Results Empower program folder item.

![Figure 4-1 Empower Program Folder](image)

**Installing the Empower Software Options**

At this point, you can install any Empower software options (i.e., System Suitability option, Chemical Structures option, etc.). The base software option is included with the server software and must be installed before you can log on to any client.

Software options are installed at any client workstation. Once an option is installed, it is active for the entire Empower network and any client has access to its features. For details
4.2 Configuring a Database Service Name

You must configure a database service name (previously called a database alias) on each client and each LAC/E32 Acquisition Server to connect to the Empower database.

To configure a database service name:

1. Select Start > Programs > Empower > Oracle > Oracle Net Configuration Assistant. The Oracle Net Configuration Assistant: Welcome page appears (Figure 4-2).

2. Click Local Net Service Name configuration, then click Next. The Net Service Name Configuration page appears.

3. Select Add, then click Next. The Database Version page appears (Figure 4-3).

on installing the Empower software options, see the Empower System Installation and Configuration Guide, Section 4.2.7, Installing Empower Licenses and Options.
4. Click **Oracle 8i or later database or service**, then click **Next**. The Service Name page appears (**Figure 4-4**).
5. Enter $\text{WAT}n$ in the Service Name field, then click $\textbf{Next}$. The Select Protocols page appears.

\textit{Note:} $n$ refers to the character in the Oracle SID name. This character is typically 5, although valid characters are 0 to 9 and A to Z. This variable is referred to throughout this guide.

When creating a net service name in order to connect to a server in which Oracle was manually installed, the following syntax should be used: SID.Host Name, Domain Name, for example, WAT5.ComputerB8C1.Waters.com.

6. Ensure that $\textbf{TCP}$ is selected, then click $\textbf{Next}$. The TCP/IP Protocol page appears (Figure 4-5).
Figure 4-5 Net Service Name Configuration, TCP/IP Protocol Page

7. Enter either the fully resolved host name (computername.domain.dns) or the TCP/IP address of the computer where the Empower database resides. Ensure that **Use the standard port number of 1521** is selected, then click **Next**. The Test page appears.

   *Note:* If you have configured additional listeners, use the appropriate port number. See Section 3.11, Configuring a Listener Service.

8. Click **Yes, perform a test**, then click **Next**. The test is automatically performed and will fail on the initial attempt due to the default user name and password, which must be changed. Click **Change Login**. Enter **System** for the user name and **Manager** for the password, then click **OK**. The test is performed and should succeed.

9. Click **Next**. The Net Service Name page appears.

10. Enter a name in the Net Service Name field, then click **Next**. The Another Net Service Name? page appears.

   *Note:* The name that you enter appears in the Database field of the Empower Login dialog box. In general, this name can be any alphanumeric string; however, when using a client with a LAC/E32 Acquisition Server, the client and the LAC/E32 Acquisition Server must have the same net service name.
11. Select **No**, then click **Next**. The Net Service Name Configuration Done Page appears.
12. Click **Next**. The Welcome page of the Net Configuration Assistant wizard appears.
13. Click **Finish**.

### 4.2.1 Defining the List of Database Aliases

When a net service name is configured, the TNSNames.ora file is modified to contain the net service name information. Normally, this file is then parsed and entries in the file populate the Database list in the Empower Login dialog box. Another way to populate this field is by using a WatNames.ora file. This allows you to define the entries in the Database list by using a simple text file. This is useful when you are using different Oracle applications and the TNSNames.ora file has grown fairly large, however, the use of a WatNames.ora file is optional. When using a WatNames.ora file, all names in the file still need to be resolved by TNSNames.ora or some other naming service. The WatNames.ora file might be present in `program-drive:\Empower\Script`.

To edit WatNames.ora:

1. In Windows Explorer, right-click the **WatNames.ora** file and click **Open With**. By default, its location is `program-drive:\Empower\Script`. The Open With dialog box appears.
2. Select **Notepad**, then click **OK**. Notepad opens and displays an empty WatNames.ora file.
3. Enter a list containing your net service names (Figure 4-6).

**Note:** If the WatNames.ora file is not already in `program-drive:\Empower\Script`, use Notepad to create it.

![Sample WatNames.ora File](image)
4. Select File > Save, then File > Exit.

To configure the use of a WatNames.ora file:

1. Select Start > Run. In the Run dialog box, enter regedit and click OK. The Registry Editor window appears.
2. In the left pane, locate HKEY_LOCAL_MACHINE\Software\Waters\Empower. Ensure that Empower is selected.
4. Right-click WatNamesOnly, then select Modify.
5. In the Edit String dialog box, enter TRUE in the Value Data field. Click OK.
6. In the left pane, ensure that Empower is selected.
7. Select Edit > New > String Value. A new value appears in the right pane. Name the string WatNamesLocation.
8. Right-click WatNamesLocation, then select Modify.
9. In the Edit String dialog box, enter the location of the WatNames.ora file in the Value Data field, for example, D:\Empower\Script. Click OK.

4.3 Registering Acquisition Server Printers

Printers are initially registered during the installation of your Empower system. If you add or delete printers later, you might need to register them again. In general, if an installed printer does not appear in the list of printers when you are using background processing and/or reporting or when you are acquiring data in Run and Report mode, it might be necessary to register the printer.

To register a printer:

1. Select Start > Programs > Empower > Register Acquisition Server Printers. The Register Acquisition Server Printers dialog box appears (Figure 4-7).
2. This dialog box lists any printers that are currently registered. If you need to register additional printers, click **Get Printers**, select the printer(s), then click **OK**.

3. If the list is acceptable, click **OK**.

   **Note:** Clicking Get Printers does not display a printer that has not been configured in the operating system. The Register Acquisition Server Printers dialog box only shows printers that have been added using Control Panel. To do so, select **Start > Control Panel > Printers**.

4.4 Deleting a Client Workstation or LAC/E³² Acquisition Server

You might want to delete a client workstation from the system if it is no longer being used, or if you need to reinstall the software on a different drive.

To delete the Empower software from a client workstation (if you are using it as an acquisition server) or from a LAC/E³² Acquisition Server:

1. Reboot the computer that you want to delete.

2. Log in to the operating system using an Administrator account on a computer other than the one that you want to delete.

3. Log in to Empower as an administrator.

4. In Configuration Manager, delete all chromatographic systems configured for the acquisition server that you want to delete. When deleting each system, click the **Delete All** button in the Delete Chromatographic System dialog box.

5. Delete the acquisition server.
6. Remove the Empower software from the computer that you want to delete using the Add or Remove applet in Control Panel.

To delete the Empower software from a client workstation if you are not using it as an acquisition server:

1. Reboot the computer.
2. Log in to the operating system using a local Administrator account on the computer that you want to delete.
3. Remove the Empower software from the client workstation with the Add or Remove Programs applet in Control Panel.

### 4.5 Starting and Logging In to Empower Software

To start Empower software on a client:

1. Select **Start > Programs > Empower > Empower Login**. The Empower Login dialog box appears (Figure 4-8).

![Empower Login Dialog Box](image)

2. Enter your user name and password. Select the net service name (database name) for your Empower server.
3. Click **Advanced** and verify that the Requested Interface field is set to Pro.

**Note:** If you do not have access to the Pro interface, you must log in with a different user account or modify the user properties of the current user account. See **Section 4.8.2, Modifying or Viewing User Accounts**, for more information.

---

**Figure 4-8  Empower Login Dialog Box**
4. Click **OK**. The Empower Pro window appears with the name of the database and the logged-on user displayed.

## 4.6 Logging Out of Empower Software

To log out of Empower software, close all Empower applications, then click **(Logout)** in the Empower Pro window. For details, see the “Logging Out” topic in the *Empower Help* Find tab.

## 4.7 Managing User Types

User types enable you to associate specific privileges to users of the Empower system. This section describes:
- Creating user types
- Modifying or viewing user types
- Deleting user types

### 4.7.1 Creating User Types

**Note:** To create a user type, you must log in to Empower software using an account with the *Create User Type* privilege.

To create a new user type:

1. Access Configuration Manager on a client.
2. Right-click in the tree pane, then select **New > User Type**. The New User type dialog box appears.
3. In the User Type text box, type a name for the new user type, then click **OK**. The User Type Properties dialog box appears.
4. In the Management tab, select the management privileges that you want to assign to this user type.

   **Note:** You cannot assign privileges that you do not have. Privileges you do not have are disabled. In order to create an administrator account, you must be logged in as an administrator. If you select the *Administrator privilege* in the Management tab, the software automatically enables all other privileges on all three tabs after you click *Apply or Close*. A message box also appears, requesting you to confirm this.

5. Click the **Methods** tab, then select the method privileges you want to assign to this user type.
6. Click the **Data Acquisition** tab, then select the data acquisition privileges you want to assign to this user type.

7. Click **OK**. The user type is created and the name of the new user type appears in the tree view under the User Types node.

### 4.7.2 Modifying or Viewing User Types

**Note:** To modify a user type, you must log in to Empower software using an account with the **Alter User Type** privilege. You cannot enable or disable privileges that you do not have.

Modify a user type when you want to change the privileges that are assigned to the user type.

To modify or view a user type:

1. Access Configuration Manager on a client.
2. Expand the User Types node in the tree pane. The list of user types is displayed under this node in the tree pane and in the view table.
3. Right-click the user type that you want to view or change, then select **Properties**. The User Type Properties dialog box appears.
4. Select or deselect privileges in the Management, Methods, and Data Acquisition tabs to add or remove them from the user type.
5. When you finish modifying the user type properties, click **OK** to save your changes in the Empower database.

**Note:** Privileges are not updated in the Empower applications that are currently running until the applications are closed and then reopened.

### 4.7.3 Deleting User Types

**Note:** To delete a user type, you must log in to Empower software using an account with the **Delete User Type** privilege.

Delete a user type when it is no longer needed.

To delete a user group:

1. Access Configuration Manager on a client.
2. Expand the User Types node in the tree pane. The list of types is displayed under this node in the tree pane and in the view table.
3. Right-click the user type that you want to delete, then select **Delete**. The Delete Confirmation dialog box appears.

**Note:** You can simultaneously delete multiple user types by selecting them in the view table with a **Ctrl-click** (multiple noncontiguous rows) or a **Shift-click** (multiple contiguous rows).
4. Click Yes or Yes to All (if you are deleting multiple user types). The user type(s) is deleted from the Empower database and is removed from the Configuration Manager tree.

4.8 Managing User Accounts

User accounts are necessary in order to log in to, and use Empower software. Waters recommends that you create an Empower user account for each individual who requires access to the Empower Enterprise or Workgroup system. Before creating a user account, you should customize user types and access privileges for each user.

Only the owner of the account should know the password. Users can change their own passwords. Only users with Administrator privileges can change other users’ passwords.

This section describes:
- Creating user accounts
- Modifying or viewing user accounts
- Deleting user accounts

4.8.1 Creating User Accounts

*Note:* To create a user account, you must log in to Empower software using an account with the Create Users privilege.

To create a user account:

1. Access Configuration Manager on a client.
2. Right-click in the tree pane, then select New > User. The New User dialog box appears.
3. In the User Name text box, type an appropriate user name (up to 30 alphanumeric characters).
4. In the Full Name text box, type the first and last names of the new user. *Note:* The Full Name field is optional when you are creating a new user account. However, if the user needs to sign off results in Preview, you must make an entry in this field. The field can also be used when you want a user's name printed on a report. Only users with the Alter Users privilege can modify this field.
5. From the User Type list, select a user type. The user type chosen determines the privileges granted to the user.
6. To require that the user enter a password when logging in to Empower software, select the Password Required check box.
Note: If you select Password Required, the new user's password is the same as the user name. The first time users log in to Empower software, they are required to change this password.

7. Select the appropriate Default User Interface and check the appropriate Allowed Interfaces.

8. Click OK. The user account is created and the name of the new user appears in the view.

Note: The following system policies affect what you can enter in the New User dialog box: Enforce Unique User Account Names, Enforce Unique User Passwords, and Enforce Minimum Password Length of N Characters. For example, if Enforce Minimum Password Length of 3 Characters is selected in the System Policies dialog box, then Password Required is automatically selected in the New User dialog box and the password must be at least three characters.

For details on system policies, see the Empower Help.

Note: Empower software uses Named User licensing. Each user account with a User Status of Active or Disabled uses one named user license. A user account with a User Status of Removed does not use a license. When there are no more licenses available, you can no longer create new user accounts.

4.8.2 Modifying or Viewing User Accounts

Note: To modify or view user properties, you must log in to Empower software using an account with the Alter Users privilege. You cannot modify the parameters in the General tab for the user named “System”. Those properties are disabled and unmodifiable.

Modify a user account when you want to change a user's Empower access privileges, available interfaces, account status, password protection, or table and plot preferences.

To modify or view user properties:

1. Access Configuration Manager on a client.

2. Expand the Users node in the tree pane. The list of users is displayed under this node in the tree pane and in the view table.

3. Right-click the user whose properties you want to view or change, then select Properties. The User Properties dialog box appears.

4. Make appropriate changes to the fields and controls in these tabs:
   - General tab – Use this tab if you need to make changes to the Full Name, User Type, Account Status or the Password fields
   - Interface tab – Use this tab if you need to make changes to the Default User Interface or Allowed Interfaces fields.
• Table Font Preferences tab – Use this tab if you need to make changes to the fonts displayed for this user in Empower tables.
• Table Color Preferences tab – Use this tab if you need to make changes to the colors displayed for this user in Empower tables.
• Plot Font Preferences tab – Use this tab if you need to make changes to the fonts displayed for this user in Empower plots.
• Plot Color Preferences tab – Use this tab if you need to make changes to the colors displayed for this user in Empower plots.

5. After modifying user properties, click **OK** to save your changes in the Empower database.

### 4.8.3 Deleting User Accounts

**Note:** To delete a user, you must log in to Empower software using an account with the Delete Users privilege.

Delete a user who no longer needs access to Empower software.

To delete an Empower user:

1. Access Configuration Manager on a client.
2. Expand the Users node in the tree pane. The list of users is displayed under this node in the tree pane and in the view table.
3. Right-click the user that you want to delete, then select **Delete**. The Delete Confirmation dialog box appears.

   **Note:** You can simultaneously delete multiple users by selecting them in the view table with a Ctrl-click (multiple noncontiguous rows) or a Shift-click (multiple contiguous rows).

4. Click **Yes** or **Yes to All** (if you are deleting multiple users). The user account(s) is deleted from the Empower database and is removed from the Configuration Manager tree.

**Note:** When you delete a user and the Enforce Unique User Account Names is enabled in the System Policies dialog box, the account remains in the list of users, however, “Removed” appears in the User Status column of the Users View table. A user with the Alter Users privilege can reenable a user account with a status of Removed by changing the status back to Active.
4.9 Managing User Groups

A user group is a set of users that can be managed together as one unit. For example, access to systems and projects is given to specific groups rather than users. This allows an administrator to easily give multiple users access to an object.

When groups are given access to an object, the group is assigned a user type which in turn dictates what privileges each user in the group has. Membership in a user group can therefore entitle you to fewer project or system privileges than what you possess as an individual user.

This section describes:
- Creating user groups
- Modifying or viewing user groups
- Deleting user groups

4.9.1 Creating User Groups

*Note:* To create a user group, you must log in to Empower software using an account with the Create User Groups privilege.

To create a user group:

1. Access Configuration Manager on a client.
2. Right-click in the tree pane, then select New > User Group. The New User Group dialog box appears.
3. In the Group Name text box, type a name for the new user group.
4. In the Group Admin drop-down list, select the user who is designated as the group administrator. The group administrator is a user who can add, remove, and modify users for that particular group but cannot add, remove, or modify users belonging to other groups. The Group Admin field is optional.
5. In the Users list box, select the users you want to belong in the new group.
6. Click OK. The user group is created and the name of the new user group appears in the view.

4.9.2 Modifying or Viewing User Groups

*Note:* To modify or view a user group, you must log in to Empower software using an account with the Alter User Groups privilege.

Modify a user group when you want to change the group administrator, add users to, or delete users from a group.
To modify or view a user group:

1. Access Configuration Manager on a client.
2. Expand the User Groups node in the tree pane. The list of user groups is displayed under this node in the tree pane and in the view table.
3. Right-click the group that you want to view or change, then select Properties. The User Group Properties dialog box appears.
4. Make the appropriate change to the group admin field, if required.
5. Select or clear user names to add or remove them from the user group.
6. When you finish modifying the user group properties, click OK to save your changes in the Empower database.

### 4.9.3 Deleting User Groups

**Note:** To delete a user group, you must log in to Empower software using an account with the Delete User Groups privilege.

Delete a user group when the users of which it is comprised no longer exist or if the group itself is no longer needed.

To delete a user group:

1. Access Configuration Manager on a client.
2. Expand the User Groups node in the tree pane. The list of groups is displayed under this node in the tree pane and in the view table.
3. Right-click the user group that you want to delete, then select Delete. The Delete Confirmation dialog box appears.

**Note:** You can simultaneously delete multiple user groups by selecting them in the view table with a Ctrl-click (multiple noncontiguous rows) or a Shift-click (multiple contiguous rows).

4. Click Yes or Yes to All (if you are deleting multiple user groups). The user group(s) is deleted from the Empower database and is removed from the Configuration Manager tree.

### 4.10 Managing Raw Data Files

The Manage Raw Data Files capability allows you to configure additional paths on your system in which to store raw data on a per-project basis. By default, project raw data is stored in the `rawdata-drive:\`Empower\Projects directory. However, you can specify any valid share on your network. The specified directory does not have to reside on an Empower server, although the Waters Service must be running on the computer where the...
Managing Raw Data Files 90

path is located. For information on installing the Waters Service, see the *Empower System Installation and Configuration Guide*, Chapter 7, Configuring a File Server.

**Adding a Raw Data Share**

To add a raw data share:

1. In Configuration Manager, select View > Manage Raw Data Files. The Manage Raw Data Files dialog box appears (Figure 4-9).

![Manage Raw Data Files Dialog Box](image)

**Figure 4-9 Manage Raw Data Files Dialog Box**

2. From the File Service list, select the name of the file service running on the computer on which you want to store your data.

3. Click Add Raw Data Share. In the Add Raw Data Share dialog box, enter the share name and click OK. If the share does not already exist, a dialog box appears allowing you to specify the directory path for the share.

When the share is created, permissions are granted to Everyone with full control access. If your corporate policy requires you to limit access to this share, change the permissions so that System (or whatever user account that is running the Waters Service) has full control and Everyone has read-only access.
When creating a new project, you can specify the raw data path the project should use to store its raw data in the Name Entry page of the New Project Wizard. Existing project data can also be moved to a different raw data share.

**Note:** The three Empower privileges associated with this capability are Create Project Path, Specify Project Path, and Change Project Path. Users must have the appropriate privilege to use the different aspects of this feature.

The Manage Raw Data Files capability allows for data storage flexibility; however, you should consider the following:

- Since this capability affects the location of data that must be backed up, you must edit your backup and restore scripts appropriately when using this feature.
- When using this capability, you can have a partial raw data failure.
- A path that is specified as a raw data path must also be shared in the operating system.
- Operating system privileges are involved when creating and specifying a share that is used as a raw data path.
- If a raw data path that is being used by a project(s) is removed, the path no longer appears on the list in the Manage Raw Data Files dialog box. However, the path is still active in that both existing and newly acquired data continues to reside in that project’s path.

**Moving Project Raw Data Files**

You can move the location in which project raw data is stored.

To move project raw data, in Configuration Manager, right-click the project and select **Move Project Data**. Optionally, data in the original location can be automatically copied to the new location and then deleted.

**Note:** It is not recommended to move the project data of projects containing large amounts of data. Move the files using operating system commands or with a backup utility.

**4.11 Copying User Preferences**

User preferences allow each user to customize specific settings in each Empower window. These settings are stored on a per-user and per-project basis. Preferences can be copied between users and projects.

To copy user preferences:

1. In Configuration Manager, select **View > Copy Preferences**. The Copy Preferences dialog box appears (**Figure 4-10**).
2. In the Copy From area, select the user and project from which you want to copy the preferences.
3. In the Copy To area, select the users and projects to which you want to copy the preferences. The preferences are copied.

4.12 Managing Database Properties

Use this section to manage the database properties by:
- Changing the Oracle database password
- Managing the tablespaces

You manage database properties through the Database Properties dialog box of the Empower Configuration Manager run from a client. For details, see the “Database Properties Dialog Box” topic in the Empower Help Find tab.
4.12.1 Changing the Empower Database Password

The Empower application uses the database password to access the database. Waters recommends that you do not change this password unless the security protocol of your company requires this. For details, see the “Changing the Oracle Database Password” topic in the Empower Help Find tab.

To change the Oracle database password:

1. Save any unsaved results.
2. Close all open applications except Configuration Manager and the Empower Pro window.
3. In Configuration Manager, select View > Database Properties. The Database Properties dialog box appears.
4. Click the Password tab.
5. Click Change Database Password. The Change Password dialog box appears.
6. Enter the old password, the new password, then confirm the new password by retyping it then click OK. The Change Password dialog box closes.
7. Click OK in the Password tab.

4.12.2 Managing the Tablespaces

A user with Administrator privileges can use the Configuration Manager Database Properties dialog box to monitor tablespace usage and modify increment size and maximum size for the Project and Index tablespaces. If you add data files to the Project or Index tablespaces, you cannot modify the incremental size and maximum size in Configuration Manager. Instead, use the Oracle Enterprise Manager Console. See the Empower System Installation and Configuration Guide for more information.

Types of Tablespaces

The Database Properties dialog box displays four database tablespaces:

- **System Tablespace** – Oracle uses this to track data dictionary information and definitions of stored procedures, packages, and database triggers.
- **Undo Tablespace** – Oracle software uses this to track database changes.
- **Project Tablespace** – Empower software uses this to track projects, chromatographic systems, and users (also called user tablespace within Oracle).
- **Index Tablespace** – Empower software uses this to store information for database indexes to cross-reference data, thereby enhancing the performance.

To manage the tablespaces, this dialog box has three features (Figure 4-11):

- **Current Tablespace Usage x of y MB** – Displays the present size (x) and current available size (y) in megabytes of the four tablespaces.
• **Extend in increments of** – Specifies the amount in MB by which a specific tablespace is increased when more tablespace is needed. Empower software automatically increments the tablespace by this amount whenever necessary, as long as disk space is available.

When setting this value, consider the current tablespace size and the maximum size. The extend size must be appropriate and allow the tablespace to increase without exceeding the maximum size specified. The extend size should be a number that is evenly divisible in the difference between the current and maximum tablespace sizes.

*Note:* This field is disabled if multiple database files exist.

• **Up to a maximum of** – Specifies the largest size in MB for a specific tablespace.

*Note:* If you customized your database – changed tablespace names, added additional tablespace data files or disabled autoextend – these fields can display zeros or be disabled.

![Figure 4-11 Database Properties Dialog Box](image)

**Attention:** The total of all tablespace maximum sizes should not exceed the available disk space.
4.13 Backing Up and Restoring Projects

This section describes:

- Configuring the backup utility (optional)
- Backing up projects on a client
- Restoring projects on a client

Use the Empower Configuration Manager to back up and restore your projects.

4.13.1 Configuring the Backup Utility (Optional)

You can use a third-party backup utility when backing up and restoring projects. For example, if you need to store project backups on tape or CD media or if the resulting backups need to be compressed, you can launch utilities to do so directly from the Empower Backup Project Wizard or the Restore Project Wizard.

To configure your backup utility:

1. Access Configuration Manager.
2. Select View > Backup Options. The Backup Options dialog box appears (Figure 4-12).

![Backup Options Dialog Box]

3. In the Button Name text box, accept the default button name (Start Backup Software) or type your own button name (for example, Start Compression Utility Name). The name you type appears on the button in the Start page of the Backup Project Wizard and the Start Software page of the Restore Project Wizard.

4. In the Preferred Backup Utility text box, enter the full path of the backup utility, or click Browse and select the path where the backup utility is located.
5. In the Command Parameters text box, enter any software switches or special command line parameters you want the backup utility to use when it runs.
6. Click OK to save your settings.

### 4.13.2 Backing Up Empower Projects

**Note:** To back up a project, you must log in to Empower software using an account with the Backup Projects privilege.

To back up a project or project(s):

1. Access Configuration Manager on a client.
2. Expand the Projects node in the tree pane. The list of projects is displayed under this node in the tree pane and in the view table.
3. In the view table, select and then right-click the project that you want to back up. If you want to back up multiple projects, use Ctrl-click (to select noncontiguous rows) or Shift-click (to select contiguous rows) to select the projects and then right-click in the selected area.
4. Select **Backup Project** from the shortcut menu. The Backup Project Wizard – Comment Entry page appears (Figure 4-13).

![Figure 4-13 Backup Project Wizard - Comment Entry Page](image)
5. Confirm that you selected the correct project(s) to back up, then enter a comment in the text box provided (a comment is required) and click Next. The Select Destination page appears (Figure 4-14).

![Figure 4-14 Backup Project Wizard - Select Destination Page](image)

6. Accept the default destination path (`rawdata-drive:\Empower\Projects`) or click the second option button and specify a different path to back up to, then click Next. The Backup Display page appears.

   **Note:** If you are backing up multiple projects, they are all backed up to the destination path that you specify but each individual project will reside in folders with the name of each project.

   Informational Oracle messages scroll in this box as the project is exported and converted to a backup format. When the export process is finished, click Next. The Start Page page appears (Figure 4-15).
7. To back up the indicated path using your third-party backup program, click **Start Backup Software** (or the name you specified for this button when you configured your backup utility in the Backup Options dialog box). See step 2.

   **Note:** A third-party backup program or other utility is optional. If you are not using an additional backup utility, do not perform this step.

8. When the backup is complete, click **Finish**.

### 4.13.3 Restoring Empower Projects

**Note:** To restore a project, you must log in to Empower software using an account with the Restore Projects privilege. To restore a Millennium 2.1x project, you first must update the project to Millennium32 version 3.xx using a special update utility. Any projects older than Millennium version 2.1x must first be updated to Millennium version 2.1x before they can be updated to Millennium32 version 3.xx. For details, see the Empower Help.

To restore a project or projects:

1. Access Configuration Manager on a client.
2. Right-click the tree pane, then select **Restore Project(s)**. The Restore Project(s) Wizard – Start Software page appears (**Figure 4-16**).
3. Click **Browse** to choose the path from which the project(s) will be restored.

   **Note:** To restore multiple projects simultaneously, the projects must be from version 3.xx or above and in the proper directory structure. The restore directory must contain a project name subdirectory for each project. The project name subdirectory must contain the raw data files, the *.inf file and the *.exp file.

   *In the Start Software page, enter the path to the folder that contains (is one level above) the multiple project subdirectories.*

4. To restore to the indicated path using your third-party backup program, click **Start Backup Software** (or the name you specified for this button when you configured your backup utility in the Backup Options dialog box).

   **Note:** A third-party backup program or other utility is optional. If you are not using an additional utility, do not perform this step.

5. When the appropriate restore path is displayed and the third-party utility is complete (if applicable), click **Next**. The Restore Project Wizard - Quota Entry page appears (**Figure 4-17**)
6. Select the raw data path where the project’s raw data should be stored. Click **Next**. The project is restored and the Restore Display page is displayed.

   **Note:** The raw data path is displayed only if you have the Specify Project Path privilege and you have configured more than one path using the Manage Raw Data Files dialog box.

   If you are restoring multiple projects at once, a Set Project Parameters page appears before the Quota Entry page. Here, you may change the name of each project, select the raw data path for each project, specify tablespace size, and view audit trail information.

7. Click **Finish** on the last page (Restore Display page) to complete the restoration process. The restored project appears in the Configuration Manager Projects View table.

   If the project is from a version of Millennium software, you will receive an update message. Click **OK**.
Audit Trail Settings for Restored Projects

If a project is restored from Millennium\textsuperscript{32} software, you might not be able to modify its audit trail settings because additional audit trail parameters have been added to the software since the version in which the audit trail feature was first introduced. If a particular setting was available in the software version in which the project was originally backed up, then the setting of the restored project is from the original project and can not be changed during the restore. If a setting was not available in the software version in which the project was backed up, then the setting can be changed as the current system policy allows, just as when you are creating new projects. Table 4-1 outlines the origin of each full audit trail setting based on the software version of the original backup.

For more information on system policies, see the *Empower Help*.

Table 4-1 Origin of Full Audit Trail Settings

<table>
<thead>
<tr>
<th>Source of Project Being Restored</th>
<th>Full Audit Trail Setting (Enabled or Disabled)</th>
<th>Method Changes Setting</th>
<th>Result Changes Setting</th>
<th>Sample Changes Setting</th>
<th>Deletion Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empower Software</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} version 4.0</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} version 3.2</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
<td>From backed up project</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} version 3.0x</td>
<td>From backed up project</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td>From current system policy</td>
</tr>
<tr>
<td>Millennium pre-version 3.0</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td>From current system policy</td>
<td>From current system policy</td>
</tr>
</tbody>
</table>
4.14 Using System Monitor

The System Monitor application allows you to monitor system database usage. Information such as which users are accessing which projects, systems, and processing servers is displayed in table form. The following four views are available:

- Users
- Systems
- Projects
- Processing Servers

To access System Monitor, select View > System Monitor from the Configuration Manager window.

For more information on System Monitor, see the Empower Help.
Chapter 5
Managing the LAC/E\(^{32}\) Acquisition Server

This chapter describes how to manage the Empower LAC/E\(^{32}\) Acquisition Servers and to perform the following:

- Setting up a LAC/E\(^{32}\) Acquisition Server
- Starting and stopping the LAC/E\(^{32}\) Acquisition Server
- Configuring a LAC/E\(^{32}\) Acquisition Server
- Deleting a LAC/E\(^{32}\) Acquisition Server

This chapter also describes the process of data buffering and data recovery.

5.1 Setting Up a LAC/E\(^{32}\) Acquisition Server

After installing the LAC/E\(^{32}\) Acquisition Server in an Empower system, you must set it up. See the Empower System Installation and Configuration Guide, Chapter 6, Installing an Acquisition Server, for the complete installation procedures.

To set up a LAC/E\(^{32}\) Acquisition Server:

- Set up the remote administration computer
- Set up the LAC/E\(^{32}\) Acquisition Server

5.1.1 Setting Up the Remote Administration Computer

Since a LAC/E\(^{32}\) Acquisition Server does not have a monitor or a keyboard and mouse, a remote administration computer is necessary when administering it. The remote administration computer connects to the LAC/E\(^{32}\) Acquisition Server using remote administration software and allows you to interact with the operating system and the software on the LAC/E\(^{32}\) Acquisition Server. The remote administration computer is generally a client located close to the LAC/E\(^{32}\) Acquisition Server but could be any computer on the Empower network. Alternatively, you can connect a keyboard, monitor, and mouse directly to the LAC/E\(^{32}\) Acquisition Server.
To set up a remote administration computer:

1. Obtain a computer with the Windows 2000 or Windows XP operating system.
2. Install the remote administration software using the provided install program. See the Empower System Installation and Configuration Guide, Appendix C, Connecting Remotely to a LAC/E³² Acquisition Server, for details.
3. Connect the remote administration computer to your network.

### 5.1.2 Setting Up the LAC/E³² Acquisition Server

To set up the LAC/E³² Acquisition Server:

1. Connect the remote administration computer to the network or connect a monitor, keyboard, and mouse to the LAC/E³² Acquisition Server.
2. Power on the LAC/E³² Acquisition Server. Windows 2000 or Windows XP boots and the remote administration software on the LAC/E³² Acquisition Server waits for user input.
3. Connect to the LAC/E³² Acquisition Server using the remote administration computer.
5. Double-click the Network icon. The Network dialog box appears.
6. Select and enter appropriate TCP/IP properties including network address, node name, and domain. Check with your network administrator to obtain the correct TCP/IP address and properties.

   **Note:** The server, all the clients, and the LAC/E³² Acquisition Server should be in the same domain.

7. Install Windows XP Professional or Windows 2000 Service Pack 2 on the LAC/E³² Acquisition Server if this has not already been done.
8. Install the Empower LAC/E³² Acquisition Server software. See the Empower System Installation and Configuration Guide.

### Enabling Autologon on the LAC/E³² Acquisition Server

Some Toolkit applications require that a Domain user be logged in. To run the autologon utility, access the LAC/E³² Acquisition Server using the remote administration software.

**Note:** Only perform this procedure if it is necessitated by your Toolkit application.

1. Select Start > Run to open the Run dialog box.
2. Enter `program-drive\Empower\Bin\autologon.exe`, then click OK. The Auto Logon dialog box appears.
3. In the Auto Logon dialog box:
   a. Click Enable AutoLogon.
   b. Enter the Domain, User Name, and Password.
   c. Click OK.

5.2 Starting, Stopping and Rebooting the LAC/E\textsuperscript{32} Acquisition Server

5.2.1 Starting the LAC/E\textsuperscript{32} Acquisition Server

Power on the LAC/E\textsuperscript{32} Acquisition Server. It automatically boots up.

\textbf{Note:} Wait at least 5 minutes for the boot process to complete before attempting a remote connection.

5.2.2 Shutting Down the LAC/E\textsuperscript{32} Acquisition Server

Use the remote administration software to shut down the LAC/E\textsuperscript{32} Acquisition Server, then power off the LAC/E\textsuperscript{32} Acquisition Server.

\textbf{Attention:} Before you shut down the LAC/E\textsuperscript{32} Acquisition Server, ensure that no acquisition is in progress using the System Monitor application available from the Configuration Manager View menu.

5.2.3 Remotely Rebooting the LAC/E\textsuperscript{32} Acquisition Server

LAC/E\textsuperscript{32} Acquisition Servers can be remotely rebooted.

To remotely reboot a LAC/E\textsuperscript{32} Acquisition Server:

1. In Configuration Manager, select one or more acquisition servers from the view pane.
2. Right-click and select Reboot from the shortcut menu. The LAC/E\textsuperscript{32} Acquisition Server is interrogated to see that no acquisition is in progress. If acquisition is taking place, a dialog box is displayed, allowing you to cancel or to continue with the reboot.
5.3 Deleting a LAC/E\textsuperscript{32} Acquisition Server

You might want to delete a LAC/E\textsuperscript{32} Acquisition Server from the system if it is no longer being used.

To delete the Empower software from a LAC/E\textsuperscript{32} Acquisition Server:

1. Reboot the computer.
2. Log in to the operating system using a local administrator account.
3. Log in to Empower with an account with Administrator privileges.
4. In Configuration Manager, delete all chromatographic systems configured for the acquisition server. When deleting each system, click the Delete All button in the Delete Chromatographic System dialog box.
5. Delete the acquisition server.
6. Remove Empower software from the computer using the Add/Remove program in Control Panel.

5.4 Buffering and Recovering Data

Empower software provides data buffering and recovery to safeguard your acquired data in the event of a server or network failure. If the LAC/E\textsuperscript{32} Acquisition Server or the acquisition client loses its connection to the Empower database or to the file server that is storing the project’s raw data, Empower stores the acquired data temporarily on the acquisition server’s hard drive on the drive where the Empower program files are installed. Once the network connection has been restored, the acquisition server resumes sending the data to the appropriate server or servers.

\textbf{Note:} Database information (sample identifiers, method information, results, and so on) is stored in the Empower database on the Empower server. By default, chromatographic raw data is stored in the rawdata-drive: Empower\Projects directory on the Empower server. However, you can change the location of raw data using the Manage Raw Data Files capability (see Section 4.10, Managing Raw Data Files) to another computer as long as the Waters Service is present. Hence, data is buffered when either the Empower database or the computer storing the project raw data (\servername\Waters\Projects$, by default) is not available on the network for any reason.
Reconnection While Buffering

When buffering is taking place, the chromatographic data that is currently being acquired is stored in the \Empower\InstrumentServer directory on the acquisition server. When this occurs, the acquisition server attempts to reconnect to the appropriate server(s) after each injection. If the acquisition server succeeds at reconnection, then the buffered injection(s) is copied over the network to the appropriate location(s). The software then deletes the raw data files on the acquisition server’s hard drive, buffering stops and normal acquisition continues.

*Note:* Occasionally, the network connection is restored but the buffered data is not automatically copied from the acquisition server to the appropriate location. If this occurs, you can manually push the data by entering `instrumentserver -recover` at the command prompt on the acquisition server. This command clears the recover log. Rename `recover.log` before using this command.

The appropriate network connection(s) must be intact before you can acquire a sample set. Immediately after acquisition of a sample set begins, the Empower software downloads all methods required to complete data acquisition to the acquisition server. This downloading sequence must be complete before acquisition and subsequent buffering can occur.

If data is still being buffered after acquisition of a sample set or a single injection is complete, the acquisition server checks the appropriate network connection every 10 minutes (approximately) until the connection is restored, at which time the data is copied to the appropriate location and then deleted from the acquisition server.

*Note:* The Empower software also buffers data from all queued sample sets, if necessary.

Continuing Acquisition While Buffering

When buffering is taking place, acquisition continues for the remainder of the queued sample sets. The following conditions exist while buffering is occurring:

- Acquisition continues in Run Only, Continue on Fault mode.
- The real-time plot may not appear in Run Samples.
- The buffered data can not be seen in the Review window.
- An “x” appears on the disk icon in the Run Samples window. (This icon is displayed in the status bar in the lower-right corner next to the clock.)

When the network connection is restored and normal acquisition resumes, these conditions no longer apply.
Chapter 6
Troubleshooting

This chapter provides guidelines for isolating and correcting system-level problems with your Empower Enterprise or Workgroup system. It describes possible symptoms and corrective actions for both hardware and software problems.

Additional Help

For additional Empower system troubleshooting help, see:

- Empower Help
- Windows XP Help or Windows 2000 Help
- Hardware documentation shipped with your system hardware
- Operator’s guides for detectors, pumps, autosamplers, and other components of the chromatography system
- Empower Software Release Notes
- www.waters.com

Waters Technical Service

If the corrective actions suggested in this chapter do not solve a problem, read Section 6.2, Reporting Problems, then call Waters Technical Service at 800 252-4752, U.S. and Canadian customers only. Other customers, contact your local Waters subsidiary or Waters Technical Service Representative, or contact Waters Corporation headquarters at 34 Maple St., Milford, Massachusetts 01757, U.S.A.

6.1 Isolating Problems

Isolating the problem is the first step in troubleshooting. Because the steps necessary to isolate a problem are often symptom-dependent, this chapter provides general instructions for isolating a problem.
Figure 6-1 shows the various paths you might follow to isolate a problem.

Figure 6-1 Isolating System Problems

6.1.1 Recommendations

Keep in mind the following recommendations when attempting to isolate a problem:

- Develop a systematic troubleshooting strategy.
• Check simple things first, such as cable connections and privileges.
• Try to reproduce a symptom and note all steps leading up to the problem.
• Make only one change at a time to identify the cause of a problem.
• Software problems in the Empower application can generate an Empower error message. If no message appears or if you cannot log in, the problem can be a setup problem.
• If you are having an instrument control problem, remove the device in question from the IEEE-488 bus and control the device from its front panel if possible. If the device does not respond as expected when programmed from its front panel, the problem is within the instrument, not within your Empower system.
• Check the Empower Message Center for errors.

6.1.2 Recording Problems

Record all system problems and troubleshooting activities in the System Problem Log. See Section A.5, System Problem Log, for sample log forms.

6.2 Reporting Problems

Before you call Waters, make sure you have adequately investigated the problem. If the corrective actions listed in this chapter do not solve the problem, collect all your troubleshooting information as well as the System Problem log and relevant technical manuals.

When you call Waters, have the following information available:

• Software support plan number
• Specific symptoms of the problem
• The severity of the problem, for example, system down, server down, PC down, PC client not connecting to server, printer printing unusual characters, or occasional malfunction
• When the problem started, whether it is reproducible, intermittent, or constant, and whether it is data-related or account-related
• The specific sequence of events leading to the problem
• Whether the system has been recently modified, new hardware or software installed, or maintenance has been performed
• Actions you took to correct the problem
• Version information for:
  – Empower software (obtain the build number from any Help About dialog box)
– Windows XP or Windows 2000 software (use the System applet in Control Panel for the software version)
– Waters HPLC devices and instruments (see the appropriate operator’s guides for information on obtaining firmware versions)
  • Basic configurations and serial numbers of the hardware components involved
  • Hard-copy examples of printouts
  • User manuals for the components

**Attention:** Be sure to call from a location that is close to the system in question. Your Waters Technical Support representative can help you more effectively if you have access to the system while you are on the telephone.

Be prepared to:
  • Swap cables if you have not already tested cables
  • Mail or FAX hard-copy documentation of the problem

### 6.3 Software Problems

*Table 6-1* includes symptoms, possible causes, and suggested corrective actions for general software problems.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>System performance degraded.</td>
<td>Not enough free disk space.</td>
<td>In Explorer, view the properties of the drives used to check free disk space. Archive or delete files if disk space is low (see Section 3.7, Managing the Server Disk Space).</td>
</tr>
<tr>
<td></td>
<td>Not enough contiguous free disk space (disk fragmentation).</td>
<td>Defragment the drive: Perform a backup (see Section 3.8, Backing Up and Restoring Server Disk Images) and restore all hard disks (see Section 3.8, Backing Up and Restoring Server Disk Images).</td>
</tr>
<tr>
<td></td>
<td>Not enough contiguous tablespace (database fragmentation).</td>
<td>Defragment the database (see Section 3.7.4, Defragmenting the Database).</td>
</tr>
</tbody>
</table>
Table 6-1 Troubleshooting Software Problems *(Continued)*

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Errors when checking disk status.</td>
<td>Problem with hard disk.</td>
<td>See the Windows XP or the Windows 2000 documentation.</td>
</tr>
<tr>
<td>Client cannot connect to the database.</td>
<td>Server is down.</td>
<td>Restart the server.</td>
</tr>
<tr>
<td></td>
<td>Listener is not running.</td>
<td>The listener is a service. Typically the name of this service is similar to OracleOraHome91TNSListener. Start the listener using the Services applet in Control Panel.</td>
</tr>
<tr>
<td></td>
<td>Client configuration problem.</td>
<td>From the client, select <strong>Start &gt; Programs &gt; Empower &gt; Oracle, Oracle Net Configuration Assistant</strong>. Select <strong>Local Net Service Name Configuration</strong>. Click the <strong>Test</strong> button, select an alias (service name), enter <strong>system</strong> for the user name, <strong>manager</strong> for the password, and click <strong>Test</strong>.</td>
</tr>
<tr>
<td></td>
<td>Network problem.</td>
<td>Ensure that the network cabling is properly connected. Use the Windows XP or Windows 2000 TCP/IP utility on the client to ping the server. When routing, ensure that the default gateway is set properly.</td>
</tr>
<tr>
<td>Client can not connect to Run Samples on LAC/E32 Acquisition Server.</td>
<td>User does not have appropriate privileges.</td>
<td>From the client, ensure that user is logged in to a domain relationship.</td>
</tr>
<tr>
<td></td>
<td>When attempting to process data using Run and Report or background processing, no results are created.</td>
<td>Ensure that the Empower path is listed before other paths in the operating system's path environment variable.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Client who is logged in as non-domain user in a domain relationship cannot connect to Run Samples on LAC/E32 (or OLE error).</td>
<td>Not a domain relationship.</td>
<td>Verify the domain relationship using Windows 2000. Look at Event Logs in Windows XP or Windows 2000 for a Failure to Connect event.</td>
</tr>
<tr>
<td></td>
<td>Logged in to wrong domain.</td>
<td>From the client, ensure that the operator is logged in to the same domain as the LAC/E32 Acquisition Server.</td>
</tr>
<tr>
<td></td>
<td>Incorrect LAC/E32 configuration.</td>
<td>Verify that the configuration on LAC/E32 server is reset to the correct parameters (see the Empower System Installation and Configuration Guide).</td>
</tr>
<tr>
<td>An error stating “No COM connection” occurs when attempting to connect to an acquisition server.</td>
<td>Either the Waters Service is not running or the acquisition server is not in a domain relationship.</td>
<td>Start the Waters Service (if the Waters Service is not on the list of services in the operating system, call Waters Technical Support) or enable two one-way trusts between the domains.</td>
</tr>
<tr>
<td>Cannot copy multi-sample sets as result tests.</td>
<td>Sample sets can have the same name.</td>
<td>Ensure that sample sets have unique names.</td>
</tr>
<tr>
<td>Client in another domain cannot access Empower resources.</td>
<td>Domain trusts are not set up.</td>
<td>Ensure there is a two-way trust between domains, or create an account in the Empower domain specifically for that user.</td>
</tr>
<tr>
<td>Run not starting, database fetch error, or connect error.</td>
<td>Incorrect database alias for LAC/E32.</td>
<td>Check the database alias on the LAC/E32 Acquisition Server for the database you are trying to connect to.</td>
</tr>
<tr>
<td>A report prints, but it does not contain any chromatograms (when using Run and Report mode).</td>
<td>No access to raw data files because NullSessionShares Registry key is not set or is improperly set.</td>
<td>See the Empower System Installation and Configuration Guide.</td>
</tr>
</tbody>
</table>
6.4 Hardware Problems

The troubleshooting tables in this section include symptoms, possible causes, and suggested corrective actions for problems with the following hardware components:

- Acquisition (Table 6-2)
- Printer (Table 6-3)

If the troubleshooting procedures in this section do not correct a problem with your system, see the manual shipped with the hardware and perform the recommended test and diagnostic procedures. If you discover a problem that requires repair of a component, check your maintenance agreement for the appropriate support organization to contact.

See the Empower Help for additional troubleshooting information, maintenance procedures, and status messages.

Table 6-2 Troubleshooting the LAC/E32 Acquisition Server

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAC/E32 Power LEDs do not glow.</td>
<td>LAC/E32 not plugged in to power outlet.</td>
<td>Connect the LAC/E32 to the power outlet.</td>
</tr>
<tr>
<td></td>
<td>LAC/E32 power not on.</td>
<td>Power on the LAC/E32.</td>
</tr>
<tr>
<td></td>
<td>No power at outlet.</td>
<td>Check power at the outlet.</td>
</tr>
<tr>
<td></td>
<td>Hardware failure.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td>Failure to connect to LAC/E32 Acquisition Server over the network or through Empower.</td>
<td>Incorrect LAC/E32 configuration.</td>
<td>Check that the LAC/E32 Acquisition Server is in the correct network domain. Check configuration of all network parameters. See Section 5.1, Setting Up a LAC/E32 Acquisition Server, to check the TCP/IP address.</td>
</tr>
<tr>
<td></td>
<td>Network card not functioning.</td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td></td>
<td>busLAC/E hardware error.</td>
<td>Call Waters Technical Service.</td>
</tr>
</tbody>
</table>
Data files not available for review because data files not copied to database server.  
Waters Service not running on LAC/E32 Acquisition Server.  
Set Waters Service Startup to Automatic, then reboot the LAC/E32 server.

Waters Service not running on database server.  
Set Waters Service Startup to Automatic, then start the service; wait up to 10 minutes for data file upload.

General networking failure.  
Call Waters Technical Service.

Cannot see print resources from Run Samples.  
Print queues not registered.  
Register print queues on the LAC/E32 Acquisition Server using Remote Administration software by selecting Start > Programs > Empower > Register Acquisition Server Printers.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data files not available for review because data files not copied to database server.</td>
<td>Waters Service not running on LAC/E32 Acquisition Server.</td>
<td>Set Waters Service Startup to Automatic, then reboot the LAC/E32 server.</td>
</tr>
<tr>
<td>Waters Service not running on database server.</td>
<td></td>
<td>Set Waters Service Startup to Automatic, then start the service; wait up to 10 minutes for data file upload.</td>
</tr>
<tr>
<td>General networking failure.</td>
<td></td>
<td>Call Waters Technical Service.</td>
</tr>
<tr>
<td>Cannot see print resources from Run Samples.</td>
<td>Print queues not registered.</td>
<td>Register print queues on the LAC/E32 Acquisition Server using Remote Administration software by selecting Start &gt; Programs &gt; Empower &gt; Register Acquisition Server Printers.</td>
</tr>
</tbody>
</table>

Table 6-3  Troubleshooting the Printer

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No response when you power on printer.</td>
<td>Power cord not connected.</td>
<td>Securely connect the power cord to the printer and wall outlet.</td>
</tr>
<tr>
<td></td>
<td>No power at wall outlet.</td>
<td>Check the wall outlet. Plug the terminal or monitor power cord into a working outlet.</td>
</tr>
<tr>
<td></td>
<td>Hardware failure.</td>
<td>Call the printer manufacturer.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Printer does not print.</td>
<td>Printer not powered on.</td>
<td>Power on the printer.</td>
</tr>
<tr>
<td></td>
<td>Printer not online.</td>
<td>Check the Ready LED on the printer. If it is not lit, see the printer owner’s guide for instructions.</td>
</tr>
<tr>
<td></td>
<td>Data or method problem.</td>
<td>Preview the file to screen. If the file previews to the screen, troubleshoot the printer. If the file does not preview to the screen, the problem is data-related or method-related.</td>
</tr>
<tr>
<td></td>
<td>Paper jammed.</td>
<td>Reload the paper. Make sure paper is threaded properly and/or the correct paper is loaded.</td>
</tr>
<tr>
<td></td>
<td>Print queues not running properly.</td>
<td>Check printer settings and properties. Use the Index tab of the Windows XP Help or the Windows 2000 Help to search for printer topics. If a queue is stopped, stalled, or paused, restart the printer.</td>
</tr>
<tr>
<td></td>
<td>Printer not connected to system.</td>
<td>Check the cable connections to the computer or network.</td>
</tr>
<tr>
<td></td>
<td>Wrong printer specified.</td>
<td>Specify the correct printer.</td>
</tr>
<tr>
<td></td>
<td>Printer error.</td>
<td>Check the printer display for an error. See the owner’s guide to troubleshoot the error.</td>
</tr>
<tr>
<td>Printer does not print (continued)</td>
<td>No batch or run and report printing.</td>
<td>Register the acquisition server printers.</td>
</tr>
<tr>
<td></td>
<td>No batch or run and report printing.</td>
<td>Check printer privileges on the printer server. Set permissions to Everyone.</td>
</tr>
</tbody>
</table>

Table 6-3 Troubleshooting the Printer (Continued)
6.5 Troubleshooting Procedures

6.5.1 Evaluating Windows XP or Windows 2000 Error Messages

System messages from the Windows XP or Windows 2000 operating system and its various utilities have a similar format. Take note of the information in the message.

For additional information, click the ? button, the Help button, or the F1 key.

Click OK after you read the message.

For more information about Windows XP or Windows 2000 operating system and utility error messages, see the Windows XP Help or Windows 2000 Help or the Microsoft Web site.

6.5.2 Evaluating Empower Error Messages

Empower software application status and error messages appear in the Message Center on the client. For details on the Message Center error messages, see the Empower Help.

If you need to call Technical Support about an error message, note the particular error and document the steps required to recreate the error before contacting Waters.

6.5.3 Evaluating Oracle Error Messages

For information about Oracle system and utility error messages, see the Oracle 9i Online Documentation Library CD. To search for a specific error, select Browse Documentation, then Lookup Error Messages. Enter an error number to search for that particular message.

If you need to call Technical Support about an error message, note the particular error and document the steps required to recreate the error before contacting Waters.
Appendix A
Log Forms

This appendix provides sample forms for logging important system information. It includes the following forms:

- Disk Space Usage Log
- Database Backup Log
- Full Disk Backup Log
- System Service Log
- System Problem Log
- Hardware Service Information Sheet
- Software Service Information Sheet
## A.1 Disk Space Usage Log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Drive</th>
<th>Free Disk Space</th>
<th>Date/Initials</th>
<th>Drive</th>
<th>Free Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### A.2 Database Backup Log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Database Disk</th>
<th>Tape Label</th>
<th># Tapes Used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### A.3 Full Disk Backup Log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Drive Volume Name</th>
<th>Tape Label</th>
<th>Backup Set Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A.4 System Service Log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Service Performed</th>
<th>Servicer/Company</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# A.5 System Problem Log

<table>
<thead>
<tr>
<th>Date/Initials</th>
<th>Problem Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### A.6 Hardware Service Information Sheet

<table>
<thead>
<tr>
<th>Hardware Technical Support/Repair Terms:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of Service Company:</td>
</tr>
<tr>
<td>Address:</td>
</tr>
<tr>
<td>Telephone Number:</td>
</tr>
<tr>
<td>Contact Person:</td>
</tr>
<tr>
<td>Service Access Number:</td>
</tr>
<tr>
<td>Service Contract Expiration Date:</td>
</tr>
</tbody>
</table>

### A.7 Software Service Information Sheet

<table>
<thead>
<tr>
<th>Software Technical Support/Repair Terms:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of Service Company:</td>
</tr>
<tr>
<td>Address:</td>
</tr>
<tr>
<td>Telephone Number:</td>
</tr>
<tr>
<td>Contact Person:</td>
</tr>
<tr>
<td>Service Access Number:</td>
</tr>
<tr>
<td>Service Contract Expiration Date:</td>
</tr>
</tbody>
</table>
## Appendix B

### Glossary

| **Account** | On a client, a user login account that allows access to the operating system and to the Empower™ application. When a user logs in, the system identifies the user by the user name and password. The user name and password inform the system about the location of user files and the user’s level of access to other files and system facilities. On the server and on the client, the system administrator uses various system accounts to access System Administration functions. |
| **Administrator** | The person designated to perform the duties necessary to ensure the most efficient, productive, and secure use of the Empower system resources. Some system administration duties are performed only once. Others must be repeated to reflect changes or growth in your laboratory needs, frequency of use, and availability of free disk space. |
| **Alert log** | A file that is created when the database is created to track specific types of database interactions. The alert log contains information about each database startup and shut down, each parameter that is not a default database value, each log thread switch, any database errors, and any data dictionary language commands used to alter the structure of the database. |
| **Archive** | Data stored offline for historical purposes with the intention of removing it from the server. Typically data at the project level is archived. |
| **Archive log** | A file created by the archiver process that contains a copy of a redo log file. |
| **Backup** | The process of storing data offline to protect it from loss in case of mechanical failure. Typically the entire disk is backed up. |
| **busLAC/E card** | A plug-in circuit board that allows electronic communication between Empower software and IEEE-488 devices (or non-IEEE-488 detectors through the I/O interface connector). The busLAC/E card converts signals to a form compatible with the receiving device. |
**Client**
A PC workstation on which you run the Empower software application. Each client is attached to the network and can access the Empower database that resides on the server.

**Cold backup**
A backup performed while the database is shut down to ensure that no processes are active within the database. Also known as an offline database backup.

**Data file**
The physical file used to store database information.

**Database**
A collection of information, electronically stored in one location, used to manipulate data in a logical way. Oracle® is a relational database that resides in an Empower stand-alone workstation or on the server in an Empower Enterprise client/server system or Empower Workgroup configuration. Information from projects, such as processed results, sample identifiers, methods, and so on, is stored in the Empower database. All data in the database is unique and cannot be overwritten.

**Database shutdown**
The action of taking an Oracle instance from a state that allows users to access the database to a dormant state. When the database is shut down, it is closed. Shutdown terminates the processes required for users to access the database, and it releases the portion or the computer’s memory within which Oracle was operating.

**Directory**
A collection of related files stored by a computer.

**Empower group**
A collection of Empower users who have access privileges, allowing the sharing of data. The administrator determines group names and users.

**Empower project**
A user-defined collection of related methods, data acquisition files, and results that can be shared with other users in the same group.

**Empower user**
A person with a valid user name and password who is logged in to the Empower application.

**Extent**
A contiguous allocation of database blocks. An extent is dedicated to a specific table, cluster, index, temporary segment, or rollback segment. An extent is created whenever a segment is created or a current segment is not large enough to hold information that is being inserted.

**File**
A collection of related information stored with a specific name on computer storage media, such as a disk. Examples of Empower files are acquired chromatographic data (raw data) files.
**Hot backup**
A backup in which the database remains running while the backup is performed. This type of backup is essential for an environment that operates 24 hours, 7 days a week. During the backup, archive log mode must be enabled. Also known as online database backup.

**IEEE-488**
A communication standard of the Institute of Electrical and Electronics Engineers for simultaneously sending digital signals over a bus cable. The IEEE-488 standard is used for communication between the LAC/E™ interface (bus or acquisition server) in the Empower system and most Waters chromatographic instruments. Each instrument communicating over the IEEE-488 bus is assigned a unique numeric address that identifies the instrument in a system.

**initWATn.ora**
A configuration file used to store nondefault Oracle values for variables.

**Instance**
A set of background processes and memory structures that access a set of database files.

**Intel server**
A computer based on the Intel® family used as a server in the Empower Enterprise client/server system or Empower Workgroup configuration.

**LAC/E³2 Acquisition Server**
Laboratory Acquisition and Control/Environment Acquisition Server. A Waters device used for instrument control and data acquisition by networking instruments in an Enterprise or a Workgroup environment.

**Listener.ora**
The primary file used to supply an Oracle listener with configuration information.

**Network printer**
A printer connected to a print server or network. Any Empower client on the network can send print jobs to the network printer.

**Offline**
A database that is currently closed and not mounted. No users can connect to the database and no data files can be accessed.

**Online**
A database that is currently mounted, open, and servicing transactions. The instance is up and users are accessing data.

**Oracle database block**
Oracle’s smallest logical storage unit. Block size is defined when the database is built.

**Physical I/O**
The act of reading information from or writing information to a physical disk.
**Privilege**  
The authority assigned to a user to access specified Empower software screens and/or functions. The user type assigned to a user account determines the available privileges.

**Process**  
A job started by the operating system that can be used to run one or more computer programs.

**Queue**  
A group of tasks waiting in sequence to be processed by the system, for example, a print queue.

**Quota**  
An allotment of space assigned to a user or process on a computer system.

**RAID**  
A redundant array of inexpensive disks used to enable the storage of data in a protected fashion.

**Recovery**  
The act of replacing damaged or deleted database files with backed up copies.

**Redo log file**  
The file that contains a copy of all data blocks that have been modified as the result of a database transaction. In the event of a system failure, any transaction can be recovered with these redo blocks. Oracle requires at least two redo log files that are written to in a round-robin fashion.

**Rollback**  
The act of undoing changes that have been made by a transaction.

**Rollback segment**  
The place in the database where redo information is kept and can be obtained if a rollback is needed.

**SAT/IN Module**  
The Waters Satellite Interface Module, an analog-to-digital (A/D) converter that has two independent A/D converter boards. The busSAT/IN™ module accepts analog data from a detector, converts it to digital data, then passes it to a busLAC/E card.

**Schema**  
An area designated within a database in which an application’s objects are stored.

**Segment**  
A collection of extents that make up a single table, index, temporary segment, or rollback segment.

**Server**  
The host computer that contains the Windows® 2000 operating system, the Empower database (projects and raw data), and the Oracle9i™ server software. The server provides access to the database, print services, and security.
**Shutdown**
The action of taking an Oracle instance from a state that allows users to access the database to a dormant state; when the database is shut down, it is closed. Shutdown terminates the processes required for users to access the database, and it releases the portion of the computer's memory within which Oracle was operating.

**Snapshot**
A picture of a table or set of tables that is captured at a point in time.

**System Global Area (SGA)**
A shared memory region Oracle uses to store data and control information for one Oracle instance. The SGA is allocated when the Oracle instance starts; it is deallocated when the Oracle instance shuts down. Each Oracle instance that starts has its own SGA. The information in the SGA is made up of the database buffers, the redo log buffer, and the shared pool; each has a fixed size and is created at instance startup.

**System Identification Number (SID)**
A name used to both differentiate between instances and to ensure the correct processes, and in turn the correct data, are being manipulated.

**Table**
The logical unit of storage for a specific collection of data. Made up of columns, a table is used to store rows of information.

**Tablespace**
The logical storage area for one or more objects in a database. A tablespace is used to logically contain tables, clusters, and indexes.

**TCP/IP address**
Transmission Control Protocol/Internet Protocol. Network protocol used by the server configuration of the Empower system with a unique address that consists of four numbers (octets) separated by periods, for example, 143.1.34.54.

**TNSNames.ora**
A file that contains connection information describing the locations of databases.

**Transaction**
A set of database statements that represents a logical unit of work or function. A database transaction starts when the first SQL statement is submitted and ends when the COMMIT or ROLLBACK has occurred.
## Index

### A

Accounts
- administrator 27
definition 125
Empower 26
managing 85
operating system 26, 29
Oracle 26, 31
system 27
Administrator
definition 125
qualifications 23
Alert log
archiving 38
definition 125
Alias, database 79
Archive log, definition 125
Archive, definition 125
Archiving projects 42
Audit trail settings 101
Autologon utility 104

### B

Backing up
database 50
disk images 48
projects 96
Backup
cold backup to drive 55
cold backup to tape 55
cold drive backup structure 60
cold tape backup structure 60
definition 125
hot backup to drive 54
hot backup to tape 55
hot drive backup structure 57
hot tape backup structure 58
utility 95
Backup media, rotating 49
Backup scripts 51
Backup utility, configuring 95
Buffered data, description 106
Buffering data 106
busLAC/E card, definition 19, 125

### C

Changing passwords
Empower 32
Oracle database accounts 93
Oracle user accounts 31
Windows user accounts 30
Client
definition 125, 126
deleting 81
software description 21
Cold backup
definition 126
to drive 55
to tape 55
Configuration of hardware 19
Configuring
backup utility 95
database service name 75
listener service 67
Contacting Waters Technical Service 108
Conventions, documentation 15
Copying user preferences 91
Creating
database instance 46
user accounts 83, 85
user groups 88
user types 83

Data buffering 106
Database
  backing up 50
  definition 126
  files 39
  restoring 56
  shutting down 36
  starting up 35
  structure 39
Database alias 79
Database instance 46
Database recovery
  database drive and raw data drive failure 66
  database drive failure 61
  program files drive failure 65
  raw data drive failure 63
  unusual conditions 66
Database service name 75
Database shutdown, definition 126
Defining database alias 79
Defragmenting
  database 43
  hard disk 43
Deleting 84
  client 81
  Empower database 45
  LAC/E32 Acquisition Server 81, 106
  user accounts 87
  user groups 89
Disk space
  checking 41
  log form 119
Documentation
  conventions 15
  related 13
Empower group, definition 127
Empower Login dialog box 82
Empower menu items 73
Empower program group 73
Empower project, definition 126
Empower user, definition 126
Error messages 117
  database fetch error 113
  disk status 112
  Empower 117
  OLE error 113
  Oracle 117
  printer 116
Exporting Empower database 45
Extent, definition 126
Files
  database 39
  definition 126
  password 32
  TNSNames.ora 129
  WatNames.ora 79
Forms, log 118
Fragmentation, checking 44
Glossary 125
Hard disk defragmenting 43
Hard disk space, checking 41
Hard drive, organization 38
Hardware
  configuration 19
  log form 124
problems 114
Hot backup
definition 127
to drive 54
to tape 55

I
IEEE-488, definition 127
Importing Empower database 46
initWATn.ora, definition 127
Installing software options 74
Instance
creating 46
definition 127
Intel server, definition 127

L
LAC/E32 Acquisition Server
definition 127
deleting 81, 106
rebooting 105
listener service 67
listener.ora, definition 127
Log forms 118
Log, system administrator 26
Logging in
Empower 82
operating system 29
Oracle 31
Logging out
Empower 83
operating system 33
Login dialog box 82

M
Managing
database properties 92
raw data files 89
user accounts 85
user groups 88
user types 83
Modifying
user accounts 86
user groups 88
user types 84

N
Name resolution 79
Net service name. See Database service
name
Network printer, definition 127

O
Offline, definition 127
Online, definition 127
Options, installing 74
Oracle accounts 31
Oracle database block, definition 127
Oracle database files 39
Oracle password file 40
Oracle_home 40

P
Password file 32
Passwords
changing 27, 30, 31, 32, 93
operating system 30
Oracle database 93
Physical I/O, definition 127
Printer, registering 80
Privilege, definition 128
Index 133

Problems, reporting 110
Process, definition 128
Projects
  audit trail settings 101
  backing up 96
  restoring 98
Q
Qualifications, administrator 23
Queue, definition 128
Quota, definition 128
R
RAID, definition 128
Raw data files, managing 89
Raw data share, adding 90
Raw data, moving 91
Rebooting, LAC/E32 Acquisition Server 105
Recovery
  database drive and raw data drive failure 66
  database drive failure 61
  definition 128
  program files drive failure 65
  raw data drive failure 63
  unusual conditions 66
Redo log file, definition 128
Registering, acquisition server printer 80
Related documentation 13
Reporting problems 110
Restoring
  database 56
  disk images 48
  projects 98
Rollback segment, definition 128
Rollback, definition 128
Rotating backup media 49
S
SAT/IN Module, definition 128
Schema, definition 128
Scripts, backup 51
Security features 27
Segment, definition 128
Server
  definition 128
  logging in to 29
  software 21
  starting up 34
Shutter down, definition 129
Shutting down
  database 36
  LAC/E32 Acquisition Server 105
  system 36
Snapshot, definition 129
Software
  client 21
  Empower 22
  installing options 74
  log form 124
  requirements 21
  server 21
Starting up
  database 35
  server 34
System administrator’s log 26
System global area, definition 129
System identification number, definition 129
System Monitor 102
System, shutting down 36
T
Table, definition 129
Tablespace 129
  definition 129
  managing 93
TCP/IP address, definition 129
Technical support 108